[image: image1.png]The Meeting Transcript of
The Los Angeles County
Board of Supervisors




[image: image2.png]The Meeting Transcript of
The Los Angeles County Board of Supervisors




March 8, 2005


[image: image3.png]The Meeting Transcript of
The Los Angeles County Board of Supervisors





          Adobe Acrobat Reader 5.0

Finding Words

You can use the Find command to find a complete word or part of a word in the current PDF document.  Acrobat Reader looks for the word by reading every word on every page in the file, including text in form fields.

To find a word using the Find command:

1. Click the Find button (Binoculars), or choose Edit > Find.

2. Enter the text to find in the text box.

3. Select search options if necessary:

Match Whole Word Only finds only occurrences of the complete word you enter in the box.  For example, if you search for the word stick, the words tick and sticky will not be highlighted.

Match Case finds only words that contain exactly the same capitalization you enter in the box.

Find Backwards starts the search from the current page and goes backwards through the document.

4. Click Find.  Acrobat Reader finds the next occurrence of the word.

       To find the next occurrence of the word: 

        Do one of the following:

        Choose Edit > Find Again 

        Reopen the find dialog box, and click Find Again.  (The word must already be in the         Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it into another application such as a word processor.  You can also paste text into a PDF document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you can switch to another application and paste it into another document.  

Note:  If a font copied from a PDF document is not available on the system displaying the copied text, the font cannot be preserved.  A default font  is substituted.

To select and copy it to the clipboard:

1. Select the text tool T, and do one of the following:

       To select a line of text, select the first letter of the sentence or phrase and drag to the last letter.  

       To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option (Mac OS) as you drag across the width of the document. 

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command (Mac OS) as you drag the length of the document.

        To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text on the current page is selected.  In Continuous or Continuous – facing mode, most of the text in the document is selected.  When you release the mouse button, the selected text is highlighted.  To deselect the text and start over, click anywhere outside the selected text.  

The Select All command will not select all the text in the document.  A workaround for this (Windows) is to use the Edit > Copy command.  

2. Choose Edit > Copy to copy the selected text to the clipboard.

3. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.

[For your information there is no reportable

action as a result of the Board of Supervisors'

closed session held today.]
SUP. MOLINA, CHAIR: GOOD MORNING. IF I COULD ASK EVERYONE TO PLEASE TAKE THEIR SEAT. THIS MORNING, OUR INVOCATION WILL BE LED BY PASTOR DEE COOPER FROM THE BRENTWOOD PRESBYTERIAN CHURCH IN LOS ANGELES. OUR UP PLEDGE THIS MORNING WILL BE LED BY SYLVESTER WARSAW, COMMANDER OF THE SAMMY DAVIS POST 784 OF THE AMERICAN LEGION. WOULD YOU ALL PLEASE STAND? PASTOR? 

PASTOR DEE COOPER: LET US PRAY. OH GOD OF CITY AND STREET, TOWN AND VILLAGE, WE THANK YOU FOR OUR CITIES AND COMMUNITIES AND FOR OUR HOMES. WE PRAY FOR ALL WHO LIVE AND WORK IN CITIES. WE PRAY FOR ALL WHO HAVE NO HOMES, WHO LIVE ON OUR STREETS. WE PRAY FOR ALL WHO WORK TO IMPROVE CITIES AND THE LIFE WITHIN THEM, FOR PLANERS AND ARCHITECTS AND BUILDERS, FOR STREET CLEANERS AND GARDENERS, FOR THOSE WHO WORK IN SOCIAL SERVICES, FOR VOLUNTEER ORGANIZATIONS, FOR RELIGIOUS BODIES AND FOR GOVERNMENT LEADERS. GIVER OF ALL OF LIFE, YOU CALL US TO LIVE IN COMMUNITY AND TEACH US TO CARE FOR ONE ANOTHER. WE PRAY FOR THOSE IN POSITION AND AUTHORITY, WHOSE ACTIONS AFFECTS THE LIVES OF OTHERS. INSPIRE THEM WITH A VISION OF THE COMMUNITY AS IT MIGHT BE, WHERE LOVE OF NEIGHBOR AND CONCERN FOR ONE ANOTHER DRIVES OUT DISCONTENT AND STRIFE, ANXIETY AND FEAR. HELP US ALL TO WORK TOGETHER WITH ONE HEART AND WILL, WITH SYMPATHY AND UNDERSTANDING TO SERVE THE COMMON GOOD. AMEN. 

SYLVESTER WARSAW, SR.: PLEASE PLACE YOUR RIGHT HAND OVER YOUR HEART, PLEASE AND JOIN ME IN THE PLEDGE OF ALLEGIANCE. [ PLEDGE OF ALLEGIANCE ] 

SUP. MOLINA, CHAIR: MS. BURKE FOR A PRESENTATION. 

SUP. BURKE: WE'RE VERY PLEASED TO HAVE SYLVESTER WARSAW, SR., AND HE LIVES IN GARDENA. HE'S FROM THE SAMMY DAVIS POST NUMBER 784. HE'S A FORMER POST CHAPLAIN AND HE SERVED IN THE MILITARY FROM '48 TO '54 AS A SERGEANT FIRST CLASS IN THE ARMY, SECOND INFANTRY DIVISION IN KOREA. HE WAS IN VARIOUS BATTLES. HE RECEIVED A GOOD CONDUCT MEDAL WITH ONE STAR, COMBAT ACTION RIBBON, KOREAN SERVICE MEDAL WITH TWO STARS. HE'S A MINISTER AND HE HAS BEEN MARRIED FOR 27 YEARS. HE GRADUATED FROM JEFFERSON HIGH SCHOOL IN LOS ANGELES. HE'S IN THE DISTRICT FOR 19 YEARS. HE WENT TO DIVINITY SCHOOL AT PACIFIC CHRISTIAN COLLEGE IN FULLERTON, AND HE'S THE COMMANDER OF SAMMY DAVIS POST NUMBER 784. THANK YOU FOR BEING HERE. [ APPLAUSE ] 

SUP. MOLINA, CHAIR: THANK YOU, MR. WARSAW. I'M GOING TO ASK OUR EXECUTIVE OFFICER TO PLEASE CALL THE AGENDA. 

CLERK VARONA-LUKENS: THANK YOU, MADAM CHAIR. 

SUP. MOLINA, CHAIR: OH, BEFORE WE PROCEED, SUPERVISOR YAROSLAVSKY HAS ARRIVED AND HOPEFULLY HE CAN TAKE A BREATH AND BE READY TO MAKE A PRESENTATION THIS MORNING. 

SUP. YAROSLAVSKY: THANK YOU, MADAM CHAIR. MADAM CHAIR, WE WERE LED IN THE INVOCATION THIS MORNING BY PASTOR DEE COOPER, WHO IS A NATIVE TEXAN. SHE ATTENDED TEXAS TEACH-- TEACH UNIVERSITY? TEXAS TECH UNIVERSITY. THAT'S BOBBY KNIGHT'S HOMETOWN NOWADAYS. WHERE SHE RECEIVED HER BACHELOR'S DEGREE IN BUSINESS ADMINISTRATION AND HER MASTER'S DEGREE IN EDUCATIONAL PSYCHOLOGY. AFTER GRADUATION, SHE FELT A CALL TO BOTH COUNSELING AND MINISTRY WORK. PASTOR COOPER RECEIVED HER MASTER'S OF DIVINITY DEGREE FROM GORDON CONWELL THEOLOGICAL SEMINARY IN 1992 AND IS ALSO A LICENSED MARRIAGE AND FAMILY THERAPIST. PASTOR COOPER SERVED AT ELLIOT PRESBYTERIAN CHURCH IN MASSACHUSETTS AND GRACE PRESBYTERIAN CHURCH IN KANSAS BEFORE COMING TO BRENTWOOD PRESBYTERIAN CHURCH IN 2004. HER COMMITMENT TO SERVING OUTSIDE THE WALLS OF HER CHURCHES IS REFLECTED IN HER MANY YEARS OF MISSION WORK IN THE COMMUNITIES WHERE PASTOR COOPER HAS LIVED. WE'RE VERY HONORED TO HAVE YOU HERE, PASTOR AND I THINK THIS BEATS KANSAS OR MASSACHUSETTS AT THIS TIME OF YEAR AND THANK YOU FOR YOUR INVOCATION. [ APPLAUSE ] 

SUP. MOLINA, CHAIR: THANK YOU SO MUCH. NEXT, I'LL CALL OUR EXECUTIVE OFFICER TO PLEASE PRESENT THE AGENDA. 

SUP. MOLINA, CHAIR: THANK YOU MADAM CHAIR. MEMBERS OF THE BOARD, WE'LL BEGIN ON PAGE 6. AGENDA FOR THE MEETING OF THE SANITATION DISTRICT NUMBERS 27 AND 35, ITEMS 1 THROUGH 4. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR BURKE, SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: AGENDA FOR THE MEETING OF THE COMMUNITY DEVELOPMENT COMMISSION, ITEM 1-D. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR KNABE, SECONDED BY SUPERVISOR ANTONOVICH. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: AGENDA FOR THE MEETING OF THE HOUSING AUTHORITY, ITEMS 1-H THROUGH 6-H. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR BURKE, SECONDED BY SUPERVISOR KNABE. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: AGENDA FOR THE MEETING OF THE PUBLIC WORKS FINANCING AUTHORITY, ITEM 1-F. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR ANTONOVICH, SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: AGENDA FOR THE MEETING OF THE REGIONAL PARK AND OPEN SPACE DISTRICT, ITEM 1-P. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR ANTONOVICH. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: BOARD OF SUPERVISORS, ITEMS 1 THROUGH 11. ON ITEM NUMBER 2, HOLD FOR SUPERVISOR KNABE AND A MEMBER OF THE PUBLIC. 

SUP. MOLINA, CHAIR: OKAY. ON THE REMAINDER, MOVED BY SUPERVISOR KNABE, SECONDED BY SUPERVISOR BURKE. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: ADMINISTRATIVE OFFICER, ITEMS 12 THROUGH 14. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR ANTONOVICH. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: CHILDREN'S PLANNING COUNCIL, ITEM 15. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR ANTONOVICH, SECONDED BY SUPERVISOR KNABE. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: COMMISSION ON JUDICIAL PROCEDURES, ITEM 16. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR BURKE, SECONDED BY SUPERVISOR KNABE. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: CONSUMER AFFAIRS, ITEMS 17 AND 18. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR KNABE, SECONDED BY SUPERVISOR BURKE. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: DISTRICT ATTORNEY, ITEM 19. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR ANTONOVICH, SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, SO ORDERED ON THAT ITEM. 

CLERK VARONA-LUKENS: HEALTH SERVICES, ITEMS 20 THROUGH 22. ON ITEM NUMBER 21, THE DIRECTOR REQUESTS A ONE-WEEK CONTINUANCE. 

SUP. MOLINA, CHAIR: ALL RIGHT. 21 WILL BE CONTINUED. ON THE REMAINDER, MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR BURKE. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: HUMAN RESOURCES. ON ITEM 23, WE HAVE A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD. 

SUP. MOLINA, CHAIR: ALL RIGHT. THAT ITEM WILL BE HELD. 

CLERK VARONA-LUKENS: MENTAL HEALTH, ITEM 24, SUPERVISOR BURKE REQUESTS A ONE-WEEK CONTINUANCE. 

SUP. MOLINA, CHAIR: THAT ITEM WILL BE CONTINUED. 

CLERK VARONA-LUKENS: PROBATION, ITEM 25. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR ANTONOVICH. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: PUBLIC SOCIAL SERVICES, ITEM 26. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR BURKE, SECONDED BY SUPERVISOR ANTONOVICH. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: PUBLIC WORKS, ITEMS 27 THROUGH 37. ON ITEM NUMBER 27, HOLD FOR A MEMBER OF THE PUBLIC. ON ITEM 31, SUPERVISOR ANTONOVICH REQUESTS A THREE-WEEK CONTINUANCE. 

SUP. MOLINA, CHAIR: ALL RIGHT. THAT ITEM IS MOVED BY SUPERVISOR KNABE, SECONDED BY SUPERVISOR YAROSLAVSKY... 

SUP. KNABE: WHAT WAS THE CONTINUANCE? 

SUP. MOLINA, CHAIR: THE CONTINUANCE IS ON ITEM NUMBER 31. 

SUP. KNABE: THREE WEEKS? 

SUP. MOLINA, CHAIR: TO THE 29TH. IS THERE A PROBLEM? 

SUP. KNABE: NO. 

SUP. MOLINA, CHAIR: OKAY. ALL RIGHT. THAT ITEM IS CONTINUED. 

CLERK VARONA-LUKENS: SHERIFF, ITEM 38. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR ANTONOVICH. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: TREASURER AND TAX COLLECTOR, ITEM 39. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR KNABE, SECONDED BY SUPERVISOR BURKE. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: MISCELLANEOUS COMMUNICATIONS, ITEMS 40 AND 41. ON ITEM NUMBER 40, AS NOTED ON THE GREEN SHEET, THE DIRECTOR REQUESTS THAT THE ITEM BE CONTINUED ONE WEEK. 

SUP. MOLINA, CHAIR: ALL RIGHT. ON THE REMAINDER, MOVED BY SUPERVISOR ANTONOVICH, SECONDED BY SUPERVISOR BURKE. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: ORDINANCES FOR INTRODUCTION, 42 THROUGH 46 AND I'LL READ THE SHORT TITLES INTO THE RECORD. 42, AN ORDINANCE AMENDING TITLE 5, PERSONNEL AND TITLE 6, SALARIES OF THE LOS ANGELES COUNTY CODE RELATING TO THE IMPLEMENTATION OF VARIOUS PROVISIONS NEGOTIATED WITH REGISTERED NURSES AND TO THE EXTENSION OF SUCH PROVISIONS TO NONREPRESENTED NURSING CLASSIFICATIONS. 43, AN ORDINANCE AMENDING TITLE 5, PERSONNEL AND, TITLE 6, SALARIES OF THE LOS ANGELES COUNTY CODE RELATING TO PEACE OFFICERS. 44, AN ORDINANCE AMENDING TITLE 6, SALARIES OF THE LOS ANGELES COUNTY CODE RELATING TO SETTING SALARIES FOR DESIGNATING LACERA PERSONNEL. 45, AN ORDINANCE RELATING TO AN EXTENSION OF A FRANCHISE TO OPERATE A CABLE TELEVISION SYSTEM IN THE UNINCORPORATED AREAS OF CLAREMONT. 46, AN ORDINANCE RELATING TO THE EXTENSION OF A FRANCHISE TO OPERATE A CABLE TELEVISION SYSTEM IN AN UNINCORPORATED AREA OF SAGAS. THOSE ITEMS ARE BEFORE YOU. 

SUP. MOLINA, CHAIR: ALL RIGHT. ON THOSE ORDINANCES, MOVED BY SUPERVISOR ANTONOVICH, SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: ORDINANCES FOR ADOPTION, ITEMS 47 THROUGH 49. ON ITEM 47, WE'RE GOING TO HOLD FOR SUPERVISOR KNABE AND A MEMBER OF THE PUBLIC. 48 AND 49 ARE BEFORE YOU. 

SUP. MOLINA, CHAIR: ON THOSE ORDINANCES, MOVED BY SUPERVISOR BURKE, SECONDED BY SUPERVISOR KNABE, IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: SEPARATE MATTERS. ITEMS 50 AND 51, ITEM 50, SUPERVISOR ANTONOVICH REQUESTS A TWO-WEEK CONTINUANCE AND SUPERVISOR MOLINA REQUESTS THAT THE ITEM BE REFERRED BACK TO THE DEPARTMENT. 

SUP. MOLINA, CHAIR: ON ITEM 50. 

CLERK VARONA-LUKENS: ON 50. 

SUP. MOLINA, CHAIR: WHAT WOULD BE THE PURPOSE OF THE CONTINUANCE, MR. ANTONOVICH? 

SUP. ANTONOVICH: THAT WAS AT THE REQUEST OF THE DEPARTMENT. 

SUP. MOLINA, CHAIR: NO. THE REQUEST OF THE DEPARTMENT WAS TO REFER IT BACK. 

SUP. ANTONOVICH: IT'S A REQUEST BUT IT WILL BE COMING BACK, SO IT DOESN'T MATTER WHICH WAY. IT'LL STILL COME BACK BEFORE US, ONE WAY OR THE OTHER, SO... 

SUP. MOLINA, CHAIR: OKAY. WE WILL REFER THAT ITEM BACK TO THE DEPARTMENT. ALL RIGHT. 

SUP. KNABE: THAT'S STILL COMING BACK, THOUGH, RIGHT? 

SUP. MOLINA, CHAIR: I HAVE NO IDEA IF IT'S COMING BACK. 

SUP. ANTONOVICH: THEY'RE STILL INVESTIGATING SO... 

SUP. YAROSLAVSKY: MADAM CHAIR, COULD I ASK THAT NEXT WEEK YOU SCHEDULE A CLOSED SESSION ITEM TO-- IF IT'S APPROPRIATE, JUST TO BRIEF US ON WHAT-- MAYBE IT'S NOT APPROPRIATE, I DON'T KNOW. 

SUP. MOLINA, CHAIR: I DON'T THINK WE'RE PERMITTED, UNDER THE MEMO, TO DO SO. 

SUP. YAROSLAVSKY: ON WHAT WE ARE-- WHAT OUR SCOPE OF-- WHAT OUR SPAN OF RESPONSIBILITY IS HERE? I MEAN, I... 

SUP. ANTONOVICH: THEY DID. THE COUNTY COUNSEL SENT US A MEMO ON THAT. 

SUP. YAROSLAVSKY: YEAH, I KNOW, WELL, I DON'T THINK IT ADDRESSED THE QUESTION I HAVE IN MIND BUT MAYBE THEY DID AND I MISSED IT. I DON'T KNOW. 

SUP. MOLINA, CHAIR: CAN WE HOLD THIS ITEM FOR A MINUTE? LET'S FINISH THE AGENDA AND THEN WE'LL PROCEED FORWARD. I APOLOGIZE. WE'LL HOLD ITEM 50 FOR A MOMENT. ITEM 51? 

CLERK VARONA-LUKENS: TREASURER AND TAX COLLECTOR'S RECOMMENDATION TO ADOPT RESOLUTION AUTHORIZING THE ISSUANCE AND SALE OF NORWALK, LA MIRADA UNIFIED SCHOOL DISTRICT GENERAL OBLIGATION BONDS ELECTION OF 2002, SERIES 2005-B IN AN AMOUNT NOT TO EXCEED $45 MILLION. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR KNABE, SECONDED BY SUPERVISOR BURKE. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: MISCELLANEOUS, ADDITIONS TO THE AGENDA REQUESTED BY BOARD MEMBERS AND THE CHIEF ADMINISTRATIVE OFFICER, WHICH WERE POSTED MORE THAN 72 HOURS IN ADVANCE OF THE MEETING, AS INDICATED ON THE GREEN SUPPLEMENTAL AGENDA. 52-A. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR BURKE, SECONDED BY MYSELF. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: 52-B. 

SUP. MOLINA, CHAIR: MOVED BY SUPERVISOR ANTONOVICH, SECONDED BY SUPERVISOR KNABE. IF THERE'S NO OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: AND THAT COMPLETES THE AGENDA. BOARD OF SUPERVISORS' SPECIAL ITEMS BEGINS WITH SUPERVISORIAL DISTRICT NO. 2. 

SUP. MOLINA, CHAIR: THIS MORNING'S PRESENTATIONS ARE GOING TO BEGIN WITH SUPERVISOR BURKE. 

SUP. BURKE: (OFF-MIKE). 

SUP. MOLINA, CHAIR: NO. LET ME TALK TO COUNSEL ON THAT. 

SUP. BURKE: I'D LIKE TO CALL COACH CARTER FORWARD. AND WE'RE VERY PLEASED TO HAVE HIM HERE. I KNOW WE HAVE ALL SEEN HIM ON TELEVISION, THIS VERY SUCCESSFUL MOVIE ON HIS LIFE, AND KEN CARTER IS AN ADVOCATE FOR YOUTH ENRICHMENT CALIFORNIA. HE HAD OVERSIGHT OF RICHMOND HIGH SCHOOL BASKETBALL PROGRAMS FROM 1997 TO 2002. HE MADE NEWS WHEN HE LOCKED OUT HIS UNDEFEATED VARSITY BASKETBALL TEAM IN ORDER TO PUSH THEM TO IMPROVE THEIR GRADES. THE COACH CLOSED THE HIGH SCHOOL GYM, BANNED ALL BASKETBALL-RELATED ACTIVITIES, AND WAS PREPARED TO CANCEL THE ENTIRE PROGRAM BECAUSE 15 OF THE 45 PLAYERS WERE NOT LIVING UP TO THE CLASSROOM ACHIEVEMENT THEY HAD AGREED TO MEET IN CONTRACTS THEY SIGNED EARLIER IN THE SEMESTER. THE OFFENDING PLAYERS INCLUDED THE COACH'S SON. IN OCTOBER 2002, HE TRAVELED FROM RICHMOND TO THE STEPS OF THE STATE CAPITOL IN SACRAMENTO TO DRAW AWARENESS TO THE DETERIORATING STATE OF SCHOOLS AND BRING STUDENTS, PARENTS AND TEACHERS AND SCHOOL BOARD OFFICIALS TOGETHER TO COMMIT TO MAKING A DIFFERENCE. COACH CARTER TRAVELED TO SACRAMENTO FROM RICHMOND ON A KICK SCOOTER, A TRIP THAT TOOK THREE DAYS AND THANKS TO HIS EFFORTS, RICHMOND HIGH RECEIVED BUILDING ENHANCEMENTS AND COMPUTERS FROM THE OFFICE OF THE SECRETARY OF EDUCATION. IN 2002, COACH CARTER HAD 11 STUDENTS FROM AUSTRALIA COME TO THE U.S. TO PROMOTE PEACE AND LEARN FIRSTHAND WHAT IT TAKES TO BE AN AMERICAN HIGH SCHOOL BASKETBALL PLAYER. HIS EFFORTS PAID OFF AS HIS SON AND OTHER BASKETBALL TEAM PLAYERS WENT OFF TO COLLEGE. COACH CARTER'S STORY IS NOW BEING SEEN IN THEATERS ACROSS THE NATION AND IT'S BEEN FEATURED IN, "COACH CARTER: THE MOVIE" STARRING SAMUEL L. JACKSON. HE'S A MOTIVATIONAL SPEAKER, AUTHOR AND LIFE COACH. HE'S ALSO FOUNDER AND CHAIR OF THE BOARD TO THE COACH KEN CARTER FOUNDATION, WHICH DEVELOPS PROMOTES AND PROVIDES EDUCATION, TRAINING MENTORING PROGRAMS FOR MINORITY YOUTH. HE RECENTLY SPOKE ON THE VILLAGE APPROACH TO LITERACY AT WASHINGTON PREPARATORY HIGH SCHOOL AND IT WAS SPONSORED BY ME AND BY-- IN CONJUNCTION WITH THE REGIONAL CONGREGATION AND NEIGHBORHOOD ORGANIZATIONS AND VARIETY AND ALSO CHILDREN'S CHARITIES BUT, MOST OF ALL, IT WAS ORGANIZED THROUGH THE COURTS AND WE HAVE THE JUDGE WHO WORKED SO HARD ON THIS BECAUSE SHE FEELS THAT IT'S SO IMPORTANT THAT YOUNG PEOPLE HAVE MOTIVATION AND THIS WAS HELD AT WASHINGTON PREP. BECAUSE IT'S NECESSARY TO GET THOSE YOUNG PEOPLE AWARE OF THE FACT THAT YOU HAVE TO NOT ONLY PLAY BASKETBALL BUT YOU HAVE TO ACHIEVE AS WELL. SO, ON BEHALF OF THE COUNTY OF LOS ANGELES, WE'D LIKE TO MAKE THIS PRESENTATION TO COACH CARTER. 

COACH CARTER: WELL, I DON'T KNOW WHO THE SPEECH WRITER IS BUT I THINK I'M GOING TAKE THEM ON TOUR WITH ME. THAT'S PRETTY GOOD. I WAS ALWAYS TOLD, AS A MOTIVATIONAL SPEAKER, THAT EVERY SPEECH SHOULD BE LIKE A LADY'S DRESS, LONG ENOUGH TO COVER ALL THE BASICS BUT SHORT ENOUGH TO KEEP YOUR INTEREST. [ LAUGHTER ] I WOULD JUST LIKE TO THANK THE COUNTY OF LOS ANGELES FOR THIS PLAQUE. I WILL PROUDLY PUT THIS ON MY WALL IN MY HOME AND JUST SHOW THE REST OF THE WORLD. I'D JUST LIKE TO THANK YOU AND THANK THE JUDGE FOR MAKING IT ALL POSSIBLE AND, AGAIN, FROM COACH KEN CARTER, I WOULD JUST LIKE TO SAY THANK YOU AGAIN. [APPLAUSE] 

SUP. BURKE: JUSTICE SCHAFFER WILL SAY A WORD, TOO. 

JUSTICE SCHAFFER: GOOD MORNING. I WAS AT A BREAKFAST, THE MULTI-FAITH BREAKFAST IN JANUARY AND I SAW THIS GENTLEMAN IN THE AUDIENCE WHO WAS TAKING PICTURES AND SO I JUST WAVED AT HIM. I HAD NO IDEA WHO HE WAS AND THEN THEY INTRODUCED HIM AND THEN I WENT OVER AND I SPOKE TO HIM AND I ASKED HIM IF THERE WAS A WAY THAT WE COULD COLLABORATE AND BRING HIM BACK DOWN TO LOS ANGELES TO DO SOMETHING FOR OUR COMMUNITIES AND THEY WERE JUST VERY, VERY GRACIOUS AND WE AGREED FOR HIM TO COME DOWN AND SPEAK TO THE CHILDREN AT WASHINGTON PREPARATORY HIGH SCHOOL YESTERDAY. THAT'S JUST THE BEGINNING OF OUR ASSOCIATION BECAUSE I HAVE LOTS OF OTHER IDEAS ON HOW WE CAN GET OUR CHILDREN MOTIVATED TO LEARN AND, IN WHAT I DO EVERY DAY, I KNOW THAT, IF YOU DON'T GET A QUALITY EDUCATION, I AM LIKELY TO SEE YOU BECAUSE YOU ARE LIKELY TO GET IN TROUBLE AS OPPOSED TO DOING WHAT YOU DO WHEN YOU GET AN EDUCATION. SO A EDUCATION IS EXTREMELY IMPORTANT TO ME IN EVERYTHING THAT I DO AND SO WE ARE GOING TO WORK VERY HARD TO MAKE SURE THAT WE EXPAND WHAT WE ARE DOING HERE IN THE LOS ANGELES AREA SO YOU'LL SEE COACH CARTER AGAIN AS WE TRY TO MOTIVATE OUR CHILDREN AND OUR YOUNG ADULTS TO DO BETTER IN EDUCATION. THANK YOU. [APPLAUSE] 

SUP. BURKE: AND JUSTICE SHAFFER HAS DRUG COURT IN COMPTON SO YOU CAN SEE WHAT HER INTEREST WAS. THAT CONCLUDES MY PRESENTATIONS. 

SUP. ANTONOVICH: SUPERVISOR YAROSLAVSKY. 

SUP. YAROSLAVSKY: MR. CHAIRMAN, THANK YOU. I'D LIKE TO ASK THE FIRE DEPARTMENT PERSONNEL WHO WERE INVOLVED WITH THE TSUNAMI TO JOIN ME UP HERE. I WANT TO HONOR A GROUP OF OUR EMPLOYEES, FIRE CHIEF FREEMAN IS HERE, WHO WERE INVOLVED IN THE RESPONSE TO THE TSUNAMI DISASTER IN SOUTHEAST AND SOUTH ASIA IN LATE DECEMBER. ONE OF THE THINGS THAT WE ARE VERY FORTUNATE, I GUESS WE'RE BOTH BLESSED AND CURSED, OF HAVING THE NEED TO TRAIN FOR DISASTERS HERE IN THE SOUTHERN CALIFORNIA AREA. OUR LOS ANGELES COUNTY FIRE DEPARTMENT IS ONE OF THE BEST TRAINED IF NOT THE BEST TRAINED ORGANIZATIONS FOR THESE KINDS OF DISASTERS, FOR EARTHQUAKES, FOR FLOODS, FOR SEARCH AND RESCUE, FOR FINDING PEOPLE WHEN THEY NEED TO BE FOUND, WHEN THEY'RE BURIED. THEY DO AN OUTSTANDING JOB. SADLY, THEY'VE HAD A LOT OF PRACTICE IN OUR PART OF THE WORLD BUT, AS A RESULT, THEY HAVE DEVELOPED AN EXPERTISE WHICH WE CAN MAKE AVAILABLE TO OTHER PARTS OF THE WORLD FOR THOSE PARTS OF THE WORLD THAT CHOOSE TO AVAIL THEMSELVES OF OUR SERVICES AND OF OUR GENEROSITY AND OUR EXPERTISE. AND THAT WAS THE CASE IN THE TSUNAMI OF THIS LAST DECEMBER. OUR LOS ANGELES COUNTY FIRE DEPARTMENT HAD A NUMBER OF PERSONNEL, WHOM WE WANT TO HONOR THIS MORNING. MR. ANTONOVICH WILL JOIN ME IN THIS. PERSONNEL WHO WERE DEPLOYED BOTH IN WASHINGTON, IN AN ADMINISTRATIVE CAPACITY, TO HELP MOVE THIS RESPONSE IN A TIMELY FASHION AS WELL AS PERSONNEL WHO WERE DEPLOYED IN SRI LANKA AND POSSIBLY SOME OTHER AREAS, I'M NOT SURE, I KNOW YOU WERE IN SRI LANKA IN SEARCH AND RESCUE MODE AND RESCUE MODE AND RECOVERY MODE, AS IT TURNED OUT. WE ARE VERY PROUD OF YOU AND VERY PROUD OF OUR LOS ANGELES COUNTY FIRE DEPARTMENT FOR BEING THE KIND OF ORGANIZATION THAT HAS DEVELOPED THIS EXPERTISE AND WE'RE VERY-- I THINK WE'RE VERY FORTUNATE IN LOS ANGELES COUNTY THAT WE'RE IN A POSITION TO MAKE YOUR EXPERTISE AVAILABLE TO PEOPLE WHEN THEY'RE FLAT ON THEIR BACK AND THEY'RE IN NEED. AND I THINK IT'S NOT ONLY A LIFESAVING ENTERPRISE BUT IT'S ALSO SHOWING THE WORLD WHAT KIND OF A COUNTY AND WHAT KIND OF A COUNTRY WE ARE. AND I THINK ALL OF US ARE HONORED BY THE SERVICE YOU PERFORM. SO, WITH THAT IN MIND, LET ME BEGIN THE PRESENTATIONS AND THEN I'LL TURN IT OVER TO MIKE. I THINK WE'RE JUST GOING TO SPLIT THEM. I DON'T KNOW IN ANY PARTICULAR ORDER BUT I WANT TO FIRST OF ALL ASK FIRE CAPTAIN JOHN BOYLE-- HE'S NOT HERE. WELL, I'LL MENTION THAT CAPTAIN BOYLE WAS DEPLOYED AT THE U.S. AGENCY FOR INTERNATIONAL DEVELOPMENT U.S.A.I.D., AND THE OFFICE OF FOREIGN DISASTER ASSISTANCE IN WASHINGTON. WE'LL MAKE SURE HE GETS HIS PROCLAMATION. FIREFIGHTER, PARAMEDIC PATRICK LONG AND-- COME ON UP, PATRICK. YOU WERE DEPLOYED ALSO IN WASHINGTON? THANK YOU. [ APPLAUSE ] 

SUP. YAROSLAVSKY: NEXT, I WANT TO ASK FIREFIGHTER SERGIO CELIS. HE'S THE CENTER ON THE L.A. COUNTY FIRE DEPARTMENT BASKETBALL TEAM. [ LIGHT LAUGHTER ] [ APPLAUSE ] 

SUP. YAROSLAVSKY: NEXT IS FIRE CAPTAIN DANIEL GORDON. [ APPLAUSE ] 

SUP. YAROSLAVSKY: BRIAN-- FIRE CAPTAIN BRIAN C. LAFAITH. [ APPLAUSE ] 

SUP. YAROSLAVSKY: LAST FOR ME IS BATTALION CHIEF JAMES W. POWERS. [ APPLAUSE ] 

SUP. YAROSLAVSKY: BATTALION CHIEF POWERS WAS IN SRI LANKA AND I THINK ALL THESE GENTLEMEN WERE DEPLOYED IN WASHINGTON, D.C. NO? SOME IN SRI LANKA? ALL RIGHT. AND MIKE HAS A NUMBER OF PRESENTATIONS. AND, AFTER HE'S DONE, I'D LIKE CHIEF FREEMAN TO SAY A WORD AS WELL. SUPERVISOR ANTONOVICH. 

SUP. ANTONOVICH: WELL, AS ZEV WAS MENTIONING ABOUT THE MEN WHO WENT TO HELP WITH THOSE INDIVIDUALS WHO WERE VICTIMIZED BY THE RECENT TSUNAMI DISASTER. THEY CAME AND THEY DID A REMARKABLE JOB BECAUSE WHAT WAS INTERESTING, THEY WERE ABLE TO PUT TOGETHER, IN LESS THAN A WEEK'S TIME, THE NECESSARY SUPPORT EMERGENCY OPERATIONS CENTER TO SERVE THOSE PEOPLE THAT PROVIDED THEM WITH THE ADDITIONAL FOOD, TONS OF FOODS, MEDICINE, WATER AND TEMPORARY SHELTERS. CAPTAIN DENNIS CROSS WAS ESPECIALLY TOUCHED BY A FAMILY WHO LOST ALL OF THEIR BELONGINGS BUT STILL OFFERED HIM A CUP OF TEA WHEN HE APPROACHED THEM. JUST AS A FAMILY THOUGHT NOTHING OF OFFERING KINDNESS TO A STRANGER, THE MEN OF THE URBAN SEARCH AND RESCUE TEAM ALSO DISPLAYED SELFLESSNESS AND EMPATHY IN THEIR ACTIONS. SO WE'RE VERY PLEASED-- THIS IS THE TYPE OF CALIBER OF INDIVIDUAL THAT IS IN OUR FIRE DEPARTMENT AND WHY WE NEED TO SUPPORT THEM AS WE HAVE BECAUSE THEY, LIKE OUR SHERIFFS, ARE THE FIRST LINE OF DEFENSE, BE IT AT HOME AND AS YOU'VE SEEN HERE, ABROAD. THEY WERE ABLE TO SERVE OUR COUNTY, OUR STATE, AND OUR NATION. SO FIRST TO FIRE CAPTAIN JOHN CRANE, WHO IS NOT HERE. DID YOU GIVE HIM A PROMOTION? OH, YOU'RE WORKING ON IT. [ LIGHT LAUGHTER ] 

SUP. ANTONOVICH: OKAY. THERE ARE TWO OTHERS ALONG WITH JOHN CRANE AND FIRE CAPTAIN TIMOTHY O'NEILL AND FIRE CAPTAIN DENNIS CROSS, THEY'RE NOT HERE BUT WE WANT TO RECOGNIZE THEM AND WE'LL GIVE THEM THEIR PROCLAMATION. EMERGENCY ROOM PHYSICIAN IS DR. STEVEN CHEN. [ APPLAUSE ] 

SUP. ANTONOVICH: AND STRUCTURAL SPECIALIST BRUCE A. COOK. CHIEF? [ APPLAUSE ] 

CHIEF FREEMAN: THANK YOU VERY MUCH. MADAM CHAIR, MEMBERS OF THE BOARD, FIRST OF ALL, ON BEHALF OF ALL THE MEMBERS OF OUR URBAN SEARCH AND RESCUE TEAM, WE WANT TO THANK YOU FOR YOUR SUPPORT IN THE BEGINNING, TO HELP OUR TEAMS BE READY AND PREPARED TO RESPOND. WE WANT TO THANK YOU, OF COURSE, FOR RECOGNIZING THEM THIS MORNING. THEY DID RESPOND TO SRI LANKA, SEVERAL WENT TO WASHINGTON, D.C., TO ASSIST WITH THE LOGISTICAL SUPPORT AND THE COORDINATION, WHICH WAS LITERALLY ALL THE WAY ACROSS THE WORLD. AND THESE MEN AND WOMEN ARE PREPARED AND READY, NOT ONLY FOR LOCAL EMERGENCIES BUT, AS YOU CAN SEE FROM THIS RESPONSE ON THE TSUNAMI DISASTER, THEY'RE READY FOR WORLDWIDE DEPLOYMENT. THEY'RE REALLY JUST ONE OF THREE TEAMS NATIONALLY THAT ARE SET UP AND PREPARED TO RESPOND INTERNATIONALLY AND SO THEY ARE TRULY SPECIAL AND UNIQUE. I WOULD LIKE TO ALSO POINT OUT THAT DR. CHIN AND BRUCE COOK ARE NOT FIREFIGHTERS, THEY'RE NOT MEMBERS OF THE FIRE DEPARTMENT BUT THEY HAVE EXPERTISE, EMERGENCY ROOM PHYSICIAN AND A STRUCTURAL SPECIALIST, WHICH CAN BE SO CRITICAL AND SO IMPORTANT IN THE EVENT OF A DISASTER, WHERE STRUCTURES ARE DAMAGED. SO THEY, TOO, HAVE BEEN WITH US FOR MANY, MANY YEARS AND, AT THE DROP OF A HAT, THEY'RE READY TO GO. THEY DID RESPOND ALONG WITH THE REST OF OUR TEAM. SO WE'RE VERY, VERY PROUD OF THEM. TRULY AN INTERNATIONAL RECOGNITION AND REACHING OUT TO PEOPLE IN NEED. SO, AGAIN, THAT IS THE COUNTY WAY TO TRY TO HELP THOSE IN NEED, SO THANK YOU FOR RECOGNIZING THEM THIS MORNING. THANKS TO YOU, GENTLEMEN, FOR YOUR RESPONSE, THANKS TO YOUR FAMILIES, WHO, ALONG WITH ME, SAT HERE WITH-- SORT OF BITING OUR NAILS HOPING THAT EVERYTHING WENT SMOOTHLY AND SAFELY, WHICH IT DID. SO, AGAIN, THANK YOU VERY MUCH. THANK YOU, MEMBERS OF THE BOARD. 

SUP. MOLINA, CHAIR: CONGRATULATIONS, GENTLEMEN. [ APPLAUSE ] 

SUP. MOLINA, CHAIR: CONGRATULATIONS AGAIN. OH, I'M SORRY. DO IT AGAIN? 

SUP. YAROSLAVSKY: STAND IN THE MIDDLE. 

SUP. MOLINA, CHAIR: OKAY, MR. KNABE? 

SUP. KNABE: THANK YOU, MADAM CHAIR, MEMBERS OF THE BOARD, LADIES AND GENTLEMEN, IT'S MY PRIVILEGE TO INVITE UP HERE HEIDI GALLEGOS, A MEMBER OF THE ROWLAND UNIFIED SCHOOL DISTRICT, DR. RON LEON, WHO WAS THE SUPERINTENDENT OUT THERE, CAPTAIN JOHN NYAT FROM THE FIRE DEPARTMENT AND NATALIE MESSIAS FROM THE LOS ANGELES SHERIFF'S DEPARTMENT. THIS YEAR MARKS THE 13TH ANNIVERSARY OF THE SAFE COMMUNITIES WEEK HERE IN LOS ANGELES COUNTY. OBVIOUSLY, THE VITALITY OF OUR COUNTY CONTINUES TO DEPEND ON HOW SAFE WE KEEP OUR HOME, OUR NEIGHBORHOODS, WORKPLACES AND COMMUNITIES. CRIME AND FEAR DIMINISH OUR TRUST IN OTHERS AND IN OUR INSTITUTIONS, THREATEN THE VERY LIFE AND WELLBEING OF OUR COMMUNITY'S HEALTH AND PROSPERITY. IN THIS TIME OF GREAT UNCERTAINTY, IT'S EVEN MORE IMPORTANT TO BE VIGILANT AND WATCHFUL OF OUR SURROUNDINGS. PEOPLE OF ALL AGES MUST UNITE ALL ELEMENTS OF THE COMMUNITY IN CREATING A SAFE, HEALTHY, CRIME-FREE ENVIRONMENT. THE MAJOR FOCUS OF THIS LONG-TERM COMMITMENT IS TO MAKE POSITIVE DIFFERENCE FOR OUR COMMUNITIES BY EDUCATING OUR YOUTH AND ADULTS, PROVIDING VERY POSITIVE ALTERNATIVES AND ROLE MODELS FOR OUR CHILDREN, BY UNIFYING THE SUPPORT OF THE LOCAL COMMUNITY. OPERATION SAFE COMMUNITY, THE ROWLAND UNIFIED SCHOOL DISTRICT ALONG WITH THE SAN DIMAS SHERIFF'S STATION HAVE PARTNERED IN THIS ENDEAVOR FOR 13 YEARS NOW AND HAVE SUCCESSFULLY INCREASED PARTICIPATION IN CRIME PREVENTION EFFORTS IN THESE COMMUNITIES. SO, ON BEHALF MYSELF AND MY COLLEAGUES, WE'D LIKE TO PRESENT THIS SCROLL TO HEIDI AND TO RON AND TO EVERYONE. AND, IN ADDITION, EACH YEAR, THE SCHOOL DISTRICT SPONSORS AN ART CONTEST FOR STUDENTS TO EXPRESS THEIR HOPES AND DREAMS FOR A SAFE COMMUNITY. SO, THIS YEAR, OUR PEACHY FOLDER WINNER IS CHRISTOPHER KIM, AN EIGHTH GRADER FROM ALVARADO MIDDLE SCHOOL AND THE BADGE WINNER, WHICH I'M WEARING PROUDLY IS SHARON CHIN, FIFTH GRADER FROM GELIC ELEMENTARY, SO WE WANT TO SAY CONGRATULATIONS AND A JOB WELL DONE. [ APPLAUSE ] 

SUP. KNABE: AND THIS IS-- FOR THOSE OF YOU THAT HAVE BEEN OUT OF SCHOOL FOR A WHILE, THIS IS A PEACHY FOLDER AND THIS IS-- RIGHT INSIDE HERE IS THE WINNING DRAWING THIS YEAR THAT CHRISTOPHER DID AND EXCELLENT JOB, YOUNG MAN. EXCELLENT JOB. OKAY. WE'LL DO THAT ONE. 

HEIDI GALLEGOS: ON BEHALF OF THE ROWLAND UNIFIED BOARD OF EDUCATION, I'D LIKE TO SAY THANK YOU TO THE COUNTY SUPERVISORS FOR HONORING PUBLIC SAFETY AND EDUCATION. THAT SEEMS TO BE THE THREAD THIS MORNING, OF EXCELLENCE IN EDUCATION AND EXCELLENCE IN PUBLIC SAFETY AND SAFE COMMUNITY FESTIVAL AND THE SAFE COMMUNITIES WEEK HONORS BOTH THAT. IT CELEBRATES EXCELLENCE IN PUBLIC SAFETY AND EDUCATION. SO, THANK YOU, AGAIN, ON BEHALF OF THE ROWLAND UNIFIED SCHOOL DISTRICT. [ APPLAUSE ] 

SUP. KNABE: ALL RIGHT. AND THE QUIET, SHY ONE. NATALIE? 

NATALIE MESSIAS: THANK YOU, SUPERVISOR KNABE AND MEMBERS OF THE BOARD. ON BEHALF OF THE SHERIFF'S DEPARTMENT, WE'D LIKE YOU TO KNOW THAT SAFE COMMUNITIES WEEK IS NOT JUST IN ONE AREA. BY GETTING THIS COUNTYWIDE PROCLAMATION, WE HAVE A NUMBER OF ACTIVITIES FROM SAFETY FAIRS, BIKE RODEOS, PROGRAMS AT ALL OF OUR SCHOOLS THROUGHOUT THE COUNTY, A LOT OF INVOLVEMENT ON BEHALF OF OUR BLOCK CLUBS AND OUR BUSINESS WATCHES AND WE HOPE THAT EVERY RESIDENT IN LOS ANGELES COUNTY WILL TAKE ADVANTAGE OF THIS WEEK AND MAKE SURE THEY'RE DOING SOMETHING AT THEIR SCHOOLS, HOUSES OF WORSHIP, THEIR OWN NEIGHBORHOODS, THEIR PLACE OF EMPLOYMENT TO MAKE SURE THAT THEY'RE DOING THEIR PART IN KEEPING THEIR COMMUNITIES SAFER. THANK YOU VERY MUCH. [ APPLAUSE ] 

SUP. MOLINA, CHAIR: DOES THAT CONCLUDE YOUR PRESENTATIONS THIS MORNING, MR. KNABE? MR. KNABE? 

SUP. KNABE: YES, I'M FINISHED. I'M SORRY. 

SUP. MOLINA, CHAIR: SUPERVISOR ANTONOVICH. THANK YOU. 

SUP. ANTONOVICH: WE'D LIKE TO RECOGNIZE A GROUP OF INDIVIDUALS WHO HAVE REALLY DONATE A LOT OF THEIR TIME, EFFORT AND ENERGY TO HELP CREATE HEALTHY FAMILIES AND THIS IS A GROUP OF INDIVIDUALS FROM THE ACADEMY OF CALIFORNIA ADOPTION LAWYERS, DAVID BAUM IS PRESIDENT AND DIANE GOODMAN, WHO IS THE PRESIDENT-ELECT. FROM THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES, WE ALSO HAVE WITH US DR. DAVID SANDERS, THE DIRECTOR, VENDU ORAH, WHO IS THE SUPERVISING CHILDREN'S SOCIAL WORKER FOR INDEPENDENT AND STEP-PARENT ADOPTION UNIT. NOW, THIS UNIQUE ABILITY OF HAVING THE ACADEMY OF CALIFORNIA ADOPTION LAWYERS COME TOGETHER AS A NONPROFIT ORGANIZATION, WHICH IS CONFIRMED-- COMPRISED OF FAMILY FORMATION AND ADOPTION LAWYERS WHO ASSIST THE PUBLIC IN IDENTIFYING FAMILY FORMATION PRACTITIONERS. THE ACADEMY PROVIDES PROFESSIONAL, PUBLIC AND JUDICIAL EVALUATION, EDUCATION, ADOPTION ON GUARDIANSHIP AND RELATED TOPICS AS IT ENCOURAGES FAIR AND BALANCED FAMILY CREATION LAWS AND REGULATIONS. ON MARCH 13TH, THEY WILL HOST THEIR FOURTH ANNUAL MAGIC OF ADOPTION DAY TO GIVE ADOPTED CHILDREN, ADOPTIVE PARENTS AND ADOPTION PROFESSIONALS THE OPPORTUNITY TO CELEBRATE THE POSITIVE ASPECTS OF ADOPTION. THIS IS VERY UNIQUE AND THESE ARE, AGAIN, INDIVIDUALS WHO HELP BRING CHILDREN AND FAMILIES TOGETHER SO THOSE CHILDREN WILL GROW UP WITH A FUTURE. SO, ON BEHALF OF THE BOARD, WE'RE GOING TO PROCLAIM MARCH 13TH AS MAGIC OF ADOPTION DAY THROUGHOUT OUR COUNTY OF LOS ANGELES AND WE'D LIKE TO PRESENT THESE SCROLLS AT THIS TIME TO DAVID AND TO DIANE. [ APPLAUSE ] 

DAVID BAUM: MADAM CHAIRWOMAN, MEMBERS OF THE BOARD OF SUPERVISORS, SUPERVISOR ANTONOVICH, ON BEHALF OF THE ACADEMY OF CALIFORNIA ADOPTION LAWYERS AND THE ACADEMY OF CALIFORNIA FAMILY FORMATION LAWYERS, IT'S MY PLEASURE AND HONOR TO ACCEPT THIS PROCLAMATION. I WANT TO INTRODUCE A PERSON WHO REALLY MAKES THE MAGIC OF ADOPTION FOR US IN THE COUNTY OF LOS ANGELES EVERY SINGLE DAY AND IT WAS A SURPRISE TO FIND HER HERE TODAY BUT, REALLY, AS LAWYERS, WE'RE, AT BEST, IMPRESARIOS IN THE FIELD OF ADOPTION. WE DO OUR WORK AND WE HELP OUR FAMILIES. IT'S THE PEOPLE IN THE TRENCHES, DAY BY DAY, DOING THE HOME STUDIES, PREPARING THE REPORTS, REPORTING TO THE COURT WHO REALLY MAKE THE MAGIC THAT IS ADOPTION IN THIS COUNTY. AND FOR THAT, I SALUTE BEN DUVORA, THE HEAD OF THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES INDEPENDENT AND STEP-PARENT ADOPTIONS UNIT AND ALL OF HER CASEWORKERS AND SUPPORT STAFF, AND I THANK THEM VERY MUCH, AS I THANK THE BOARD OF SUPERVISORS. [ APPLAUSE ] 

DR. DAVID B SANDERS: THANK YOU, SUPERVISOR ANTONOVICH AND TO THE BOARD OF SUPERVISORS. THE ACADEMY OF CALIFORNIA ADOPTION LAWYERS IN OUR DEPARTMENT, INDEPENDENT AND STEP-PARENT ADOPTION UNIT WILL HAVE WORKED TOGETHER EFFECTIVELY AS PARTNERS FOR MANY YEARS AND I WANT TO CONGRATULATE THE ACADEMY AND PRESIDENT DAVID BAUM ON THEIR FOURTH ANNUAL MAGIC OF ADOPTION DAY, WHICH IS ONE OF MANY FINE EXAMPLES OF THEIR EFFORTS TO INCREASE ADOPTION AWARENESS AND CELEBRATE ADOPTIVE FAMILIES. AND JUST TO CLOSE, BECAUSE IT'S SUCH TREMENDOUS WORK BUT JUST TO GIVE A SENSE OF THE IMPACT, OVER THE LAST SIX YEARS, OUR SUCCESSFUL PUBLIC/PRIVATE PARTNERSHIP HAS RESULTED IN THE FINALIZATION OF 4,660 INDEPENDENT STEP AND STEP PARENT ADOPTIONS. AND SO THAT'S OVER 4,000 CHILDREN WHO HAVE PERMANENT FAMILIES AND MUCH BETTER LIVES AS A RESULT OF THE WORK OF THE ACADEMY. SO THANK YOU VERY MUCH. [ APPLAUSE ] 

DIANE GOODMAN: HI. BOARD OF SUPERVISORS, SUPERVISOR ANTONOVICH, THANK YOU FOR HAVING US HERE TODAY. I'M THE PRESIDENT-ELECT OF THE ACADEMY AND LOOK FORWARD TO STEPPING INTO DAVID'S SHOES NEXT YEAR AND WORKING WITH THE BOARD AND WORKING WITH BIN DUE, THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES AND CONTINUING TO GET OUR HOME STUDIES DONE, GET THESE CHILDREN PLACED FOR ADOPTION AS QUICKLY AS POSSIBLE AND THANK YOU. [ APPLAUSE ] 

SUP. ANTONOVICH: NOW WE WOULD LIKE TO RECOGNIZE A GROUP OF YOUNG PEOPLE FROM THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES ENRICHMENT PLUS PROGRAM AND DR. DAVID SANDERS, AGAIN, WILL BE HERE TO ASSIST. AND WE WANT TO THANK THE DEPARTMENT BUT RECOGNIZE THESE INDIVIDUALS WHO HAVE DONE A LITTLE BIT MORE-- A LITTLE BIT EXTRA TO ACHIEVE ACADEMIC EXCELLENCE AND TO PURSUE A QUALITY EDUCATION. SPECIAL THANKS GO TO THE PARENTS, RELATIVES, FOSTER CARE PROVIDERS FOR THE GUIDANCE, MOTIVATION THAT THEY HAVE PROVIDED THESE YOUNG PEOPLE. AND WITH THIS, WE WOULD LIKE TO ALSO RECOGNIZE THAT A 50-DOLLAR GIFT CERTIFICATE FROM BARNES AND NOBLE TO HONOR THEIR ACHIEVEMENTS WILL ALSO BE GIVEN TO THEM WITH THE PROCLAMATION. SO, FIRST, WE'D LIKE TO RECOGNIZE FOR MOST IMPROVED ACADEMIC ACHIEVEMENTS IS KIERRA JONES. [ APPLAUSE ] 

SUP. ANTONOVICH: MOST IMPROVED ACADEMIC ACHIEVEMENT IS JAMES GOLDEN. [ APPLAUSE ] 

SUP. ANTONOVICH: BEST ACADEMIC ACHIEVEMENT, LAMAR JACKSON. [ APPLAUSE ] 

SUP. ANTONOVICH: BEST ACADEMIC ACHIEVEMENT, JOSE VARGAS. [ APPLAUSE ] 

SUP. ANTONOVICH: BEST ACADEMIC ACHIEVEMENT IS DESIREE WHITE. [ APPLAUSE ] 

SUP. ANTONOVICH: AND BEST EDUCATIONAL ALLIANCE, ANTHONY THOMAS. [ APPLAUSE ] 

DR. DAVID B. SANDERS: I WANT TO AGAIN THANK SUPERVISOR ANTONOVICH AND THE BOARD OF SUPERVISORS FOR THE RECOGNITION OF THE ACADEMIC ACHIEVEMENT OF THESE YOUTH AND OBVIOUSLY ALL OF US KNOW THE IMPORTANCE OF SUCCESS IN SCHOOLS AND THESE YOUTH ARE THE VERY BEST EXAMPLES IN THIS COMMUNITY. AND I WANT TO THANK THE Y.O.U. BOARD FOR THEIR CONTINUED SUPPORT OF YOUTH IN FOSTER CARE AND THE SUPPORT AROUND ACADEMICS AND TO BARNES AND NOBLE FOR THEIR GIFT CERTIFICATES. AND I BELIEVE-- DID YOU WANT TO SAY SOMETHING? WE HAVE ONE OF OUR HONOREES WHO HAS A COUPLE OF WORDS. 

LAMAR JACKSON: GOOD MORNING. I'D JUST LIKE TO BE RECOGNIZED AS I WASN'T ALWAYS-- I WASN'T ALWAYS SUCCESSFUL ACADEMICALLY. LIKE, IT WAS A POINT IN MY LIFE WHERE I WASN'T IN SCHOOL AND I WASN'T DOING GOOD AND THINGS WASN'T DOING GOOD FOR ME, YOU KNOW, AND IT WAS, LIKE, I UNDERSTOOD WHAT I NEEDED TO DO IN ORDER TO DO, BECAUSE I HAD OTHER PEOPLE-- LIKE, I WAS ALWAYS TOLD WHAT I WAS SUPPOSED TO DO BUT, ACTUALLY, LIKE, BUT WHEN I WAS OUT THERE AND I WAS ON MY OWN, I STILL DID THE THINGS THAT WAS WRONG. BUT IT TOOK THE EXPERIENCE FOR ME TO GO THROUGH WHAT THE PEOPLE WAS TRYING TELLING ME-- THE THINGS THAT THEY TOLD ME THAT WAS WRONG, IT TOOK THE EXPERIENCE FOR ME TO GO THROUGH THAT TO UNDERSTAND WHAT I REALLY NEEDED TO DO. SO WHAT I DID WAS I HAD TO LEARN HOW TO SEPARATE MYSELF FROM THE PEOPLE THAT BRUNG ME DOWN, YOU KNOW, AND WHEN I WAS A LITTLE YOUNGER, LIKE, MY MOM, LIKE, I'VE BEEN IN FOSTER CARE SINCE HE WAS PROBABLY, LIKE, 15, 13, YOU KNOW, AND I TRIED TO STAY-- MY MOM, YOU KNOW, IT WAS-- YOU KNOW, WE STAYED TOGETHER FOR A LOT BUT IT WAS A POINT IN TIME WHERE I WASN'T STAYING WITH HER NO MORE, YOU KNOW, THEN I WAS GOING TO SCHOOL. SO WHEN I FINALLY DECIDED TO CHANGE MY LIFE AROUND, ONE OF THE ACTIVITIES THAT TOOK MY FOCUS AWAY FROM THE STREETS AND HANGING AROUND WITH THE PEOPLE THAT WAS BRINGING ME DOWN WAS SPORTS. SO WHEN I MYSELF INVOLVED IN SPORTS, WHICH-- MY NUMBER ONE SPORT IS TRACK AND FIELD, I'M A TRACK ATHLETE. AND, SO, ONCE I STARTED INVOLVING MYSELF WITH THAT, I HAD TO FOCUS MYSELF TO BRING MY GRADES UP BECAUSE YOU CAN'T, YOU KNOW, BE PARTICIPATING IN A SPORT ACTIVITY IF YOUR GRADES AIN'T UP, SO THAT'S ONE REASON WHY MY GRADES STARTED GOING UP BECAUSE I HAD TO BE IN A CLASSROOM. I HAD TO BE AT SCHOOL IN ORDER TO BE THERE FOR PRACTICE AT THE SCHOOL AND I ALSO HAD TO MAINTAIN A 2.0 JUST TO PARTICIPATE IN A SPORT ACTIVITY. AND THEN, SO, I WAS STAYING WITH AN AUNT OF MINE WHO REALLY WASN'T AN AUNT BUT IT WAS JUST A FRIEND WHO TOOK ME IN BECAUSE I DIDN'T HAVE NO PLACE TO STAY, ME AND MY YOUNGER BROTHER. AND THEN SO, AFTER AWHILE I WAS STAYING WITH THEM, IT WAS A TIME WHERE THEY COULDN'T TAKE CARE OF ME AND MY YOUNGER BROTHER ANY MORE BECAUSE, YOU KNOW, SHE HAD KIDS OF HER OWN AND THINGS IN THAT SENSE. SO WHAT HAPPENED WAS THE COACH, THE TRACK COACH AT MY SCHOOL, GEORGE WASHINGTON PREPARATORY HIGH SCHOOL, I TOLD HIM, I SAID MY SITUATION AND I TOLD HIM THAT, YOU KNOW, THAT I MIGHT BE LEAVING BECAUSE I DON'T HAVE NO PLACE TO STAY OUT HERE. SO, YOU KNOW, HE TOOK ME IN. THIS WAS IN MAY, 2003. SO, EVER SINCE THEN, I'VE BEEN STAYING WITH MY TRACK COACH, ME AND MY YOUNGER BROTHER, HE TOOK BOTH OF US IN. HE HAVE A SON OF HIS OWN SO HE ALREADY HAD THINGS THAT HE WAS DEALING WITH BUT HE STILL TOOK ME IN SO I CAN STAY AND STAY WITH HIM SO I CAN CONTINUE TO PARTICIPATE IN TRACK, YOU KNOW? AND I JUST WANT TO TAKE THIS TIME TO THANK HIM AND TO RECOGNIZE HIM FOR THE THINGS THAT HE DID FOR ME AND MY YOUNGER BROTHER, YOU KNOW? [ APPLAUSE ] 

LAMAR JACKSON: THANK YOU ALL. SO I WENT FROM A STUDENT WHO DIDN'T GO TO SCHOOL WHO GOT, EVENTUALLY, ALMOST DIRECT FAILS BUT NOW I'M STANDING HERE, I'M BEING RECOGNIZED FOR ACADEMIC ACHIEVEMENT, YOU KNOW, AND I, RIGHT NOW, I HAVE A 3.5 GRADE POINT AVERAGE. I'M ON THE TRACK TEAM, YOU KNOW, I'M IN A FELLOWSHIP OF CHRISTIAN ATHLETES PROGRAM. I'M IN LEADERSHIP, YOU KNOW, I'M IN A MENTORS GROUP PROGRAM CALLED GAMMA ZIE SCHOLARS. I'M IN A RECORDING CLUB, YOU KNOW, JUST ALL THE THINGS THAT I HAVE TO DO TO HAVE TO JUST INVOLVE MYSELF IN ALL THESE ACTIVITIES SO I CAN TAKE MYSELF, MY MINDS AND MY-- ALL MY OTHER FOCUS OFF THE NEGATIVE THINGS. SO THAT'S ALL I WOULD LIKE TO SAY THIS MORNING. THANK YOU. 

SUP. MOLINA, CHAIR: CONGRATULATIONS TO ALL OF YOU. VERY WELL DESERVED. [ APPLAUSE ] 

SUP. MOLINA, CHAIR: IT IS WONDERFUL TO CELEBRATE ACADEMIC EXCELLENCE EVERYWHERE. IT'S MY PLEASURE AT THIS TIME TO PRESENT OTHER INDIVIDUAL WINNERS. L.A. COUNTY ALWAYS ENJOYS CELEBRATING THE ANNUAL MOCK TRIAL COMPETITION. I'M GOING TO ASK ALL OF THE PEOPLE PARTICIPATING TO COME UP AND JOIN US. THIS YEAR IS THE 27TH ANNUAL TRIAL COMPETITION. AS MOST OF YOU KNOW, THE MOCK TRIAL PROGRAM HAS EXISTED SINCE 1980 AND WAS DESIGNED TO GIVE STUDENTS THE WORKING KNOWLEDGE OF OUR ENTIRE JUDICIAL SYSTEM. THIS PROGRAM IS SPONSORED BY THE CONSTITUTIONAL RIGHTS FOUNDATION AND IS CO-SPONSORED BY THE CALIFORNIA DEPARTMENT OF EDUCATION, THE STATE BAR OF CALIFORNIA, THE CALIFORNIA YOUNG LAWYERS ASSOCIATION AND THE DAILY JOURNAL CORPORATION AS WELL. IN THE MOCK TRIAL PROGRAM, THE STUDENTS WORK WITH TEACHER, SPONSOR AND ATTORNEY COACH TO STUDY ALL ASPECTS OF A COURT CASE. THEN THEY PREPARE STRATEGIES AND ARGUMENTS FOR THE MOCK TRIAL. STATEWIDE, THE PROGRAM ENGAGES OVER 8,000 STUDENT PARTICIPANTS. ALL OF THEM LEAVE THE PROGRAM WITH AN IMPROVED COMMUNICATIONS SKILLS, SHARPER ANALYTICAL SKILLS AND A DEEPER KNOWLEDGE OF THE HISTORY IN SOCIAL SCIENCES AS WELL. BUT, MOST IMPORTANTLY, THEY LEAVE A PROGRAM WITH A GREATER UNDERSTANDING OF THEIR OBLIGATIONS AND RESPONSIBILITIES AS A PARTICIPATING MEMBER OF OUR SOCIETY. IT IS FOR THIS REASON THAT WE'RE ESPECIALLY PROUD TO MAKE PRESENTATIONS HERE TODAY OF SOME OF THE WINNERS AND THE RUNNER-UPS AS WELL. WE HAVE, FROM LOUISVILLE HIGH SCHOOL, THIS TEAM EARNED THIS YEAR'S SENIOR DIVISION CHAMPIONSHIP AND WILL PROCEED TO THE STATE FINALS, AND I'M VERY PROUD TO PRESENT A SCROLL SIGNED BY ALL FIVE BOARD MEMBERS AND CONGRATULATIONS FOR AN OUTSTANDING JOB. [ APPLAUSE ] 

SUP. MOLINA, CHAIR: SOME OF THE STUDENTS HAD TO GO BACK A LITTLE BIT EARLIER. WE ALSO WANT TO CELEBRATE GAVELINO HIGH SCHOOL. THEY ACHIEVED THE SENIOR DIVISION RUNNER-UP TITLE AS WELL AND WE WANT TO CONGRATULATE THEM. NEXT, WE HAVE THE TEAM FROM THE RIVERA HALL MIDDLE SCHOOL. THEIR TEAM WON THIS YEAR'S JUNIOR DIVISION CHAMPIONSHIP, AND WILL ALSO PROCEED TO THE STATE FINALS. SO CONGRATULATIONS. [ APPLAUSE ] 

SUP. MOLINA, CHAIR: WE ALSO WANT TO THANK THE JEFFERSON B. MIDDLE SCHOOL. THEIR TEAM ACHIEVED THE JUNIOR DIVISION RUNNER UPS AS WELL. AND, OF COURSE, NONE OF THIS WOULD BE POSSIBLE WITHOUT THE DEVOTION OF NUMEROUS HARD WORKING TEACHERS WHO, AS YOU KNOW, DEDICATE COUNTLESS HOURS TO PREPARE THE STUDENTS FOR THIS KIND OF MOCK TRIAL COMPETITION. WE ALSO WOULD LIKE TO HAVE PAID HONOR TO ED KABEAL. HE IS FROM JOHN MUIR MIDDLE SCHOOL AND HE WAS THE RECIPIENT OF THIS YEAR'S HELEN BERNSTEIN OUTSTANDING TEACHER AWARD BUT HE IS TODAY TEACHING, SO HE WASN'T ABLE TO JOIN US THIS MORNING BUT WE WANT TO CONGRATULATE HIM. BEFORE I CONGRATULATE THEM ALL, WHY DON'T WE HAVE-- IS THERE A TEAM CAPTAIN ON YOUR SIDE THAT WOULD LIKE TO SAY A COUPLE OF WORDS FROM LOUISVILLE? WHERE IS THAT? DO YOU WANT TO COME UP AND SHARE A COUPLE OF WORDS OF ENCOURAGEMENT TO ALL OF US ABOUT HOW THIS PROGRAM IS WORKING AND THE SUCCESS OF YOUR TEAM? 

SPEAKER: WELL, I'D JUST LIKE TO THANK, FIRST OF ALL, THE BOARD OF SUPERVISORS FOR HAVING US HERE TODAY. THIS IS A WONDERFUL HONOR. WE APPRECIATE IT VERY MUCH. THE MOCK TRIAL PROGRAM, I'VE BEEN ASSOCIATED WITH FOR 20 YEARS OR SO NOW. IT IS A REMARKABLE PROGRAM. THE CONSTITUTIONAL RIGHTS FOUNDATION DOES AN INCREDIBLE JOB WITH THOUSANDS OF STUDENTS, GETTING THEM INTO COURTROOMS AND ALLOWING THEM TO LEARN AN INCREDIBLE AMOUNT ABOUT THE LAW, LEARN A LITTLE BIT ABOUT ACTING, LEARN ABOUT TEAM WORK, LEARN ABOUT SACRIFICE FOR THE GREATER GOOD AND WILL PREPARE THEM, CERTAINLY, FOR LAW SCHOOL FOR MANY OF THEM, WHICH WE'VE HAD A NUMBER OF STUDENTS GO TO LAW SCHOOL AFTER DOING THE MOCK TRIAL PROGRAM. SO WE'RE VERY HAPPY TO BE HERE TODAY. WE'RE VERY MUCH LOOKING FORWARD TO PARTICIPATING IN THE STATE CHAMPIONSHIP IN RIVERSIDE. WE'RE WORKING VERY HARD AND WE'RE GOING TO HOPEFULLY MAKE LOS ANGELES VERY PROUD OF US. THANK YOU VERY MUCH. 

SUP. MOLINA, CHAIR: YVONNE, I WANT YOU TO KNOW, IT LOOKS LIKE IT'S AN ALL-WOMAN TEAM THERE THAT'S ON ITS WAY. CONGRATULATIONS. [ APPLAUSE ] 

SUP. MOLINA, CHAIR: WHO WOULD LIKE TO BE THE SPOKESPERSON? 

SPEAKER: GOOD MORNING. THANK YOU VERY MUCH FOR HAVING US HERE. RIVERA HALL LUTHERAN SCHOOL IS VERY PROUD TO BE HERE AND TO BE RECOGNIZED BY YOU. WE'RE A VERY SMALL SCHOOL, ONLY 207 STUDENTS, 74 IN THE MIDDLE SCHOOL, AND 22 OF THOSE STUDENTS WERE ON THE MOCK TRIAL TEAM. I THINK ONE OF THE MOST IMPORTANT THINGS WE SAW FROM THIS PROGRAM IS HOW CRITICAL THINKING SKILLS WERE DEVELOPED. IT IS A WONDERFUL PROGRAM. I HOPE IT GOES ON FOREVER. THANK YOU VERY MUCH. [ APPLAUSE ] 

SUP. MOLINA, CHAIR: AGAIN, I THINK THAT THIS PROGRAM IS ONE OF THE OUTSTANDING PROGRAMS THAT WE CELEBRATE EVERY SINGLE YEAR. WE CONGRATULATE EVERY SINGLE ONE OF YOU, WE LOOK FORWARD TO WELCOMING YOU BACK AS WINNERS. RIGHT? AS CHAMPIONS OVERALL BUT WE CONGRATULATE YOU FOR THE OUTSTANDING PERFORMANCE. CONGRATULATIONS TO ALL OF YOU. [ APPLAUSE ] 

SUP. ANTONOVICH: NOW WE WOULD LIKE TO BRING UP DAISY, WHO IS A 12-WEEK OLD FEMALE LABRADOR MIX, WHO IS LOOKING FOR A HOME, PERHAPS ONE OF THE PEOPLE BEING HONORED TODAY WOULD LIKE TO ADOPT DAISY. SO THIS IS DAISY, IF YOU'D LIKE TO ADOPT DAISY. LOOKING FOR A HOME. THOSE AT HOME COULD CALL THE TELEVISION NUMBER AT (562) 728-4644 OR THOSE IN THE AUDIENCE AND LITTLE DAISY CAN BE YOURS FOR EASTER OR PASSOVER THAT'S COMING UP. SEE UNCLE DON? DID YOU STAKE OUT YOUR TERRITORY? 

SUP. MOLINA, CHAIR: ALL RIGHT. THAT CONCLUDES ALL OF THIS MORNING'S PRESENTATIONS. JUST AS A CLARIFICATION AND MOVING FORWARD, ON ITEM 50, I'VE BEEN TOLD BY COUNTY COUNSEL THAT THERE WILL BE A REPORT BACK TO THE BOARD MEMBERS BUT RIGHT NOW, THE APPROPRIATE REFERRAL WOULD BE TO REFER BACK TO THE DEPARTMENT. SO, WITH THAT, WE WILL REFER THAT ITEM BACK TO THE... 

SUP. KNABE: SO, I MEAN, IT'S NOT GOING DISAPPEAR. IT WILL COME BACK TO US WITH A REPORT, IS THAT CORRECT? 

SUP. MOLINA, CHAIR: THAT'S CORRECT. 

SUP. KNABE: BY REFERRING IT TO THE DEPARTMENT-- WHY ARE YOU LOOKING AT ME LIKE THAT? 

LEELA KAPUR, COUNSEL: SUPERVISOR KNABE, IF YOU REFER IT BACK TO THE DEPARTMENT, IT WILL NOT BE SET FOR ANOTHER AGENDA. 

SUP. MOLINA, CHAIR: THAT'S WHAT WE'RE SAYING. IT WILL NOT BE SET. 

LEELA KAPUR, COUNSEL: BUT THERE WILL BE A REPORT TO THE BOARD. 

SUP. KNABE: OKAY. ALL RIGHT. 

SUP. MOLINA, CHAIR: IS THAT UNDERSTOOD? OKAY. GOOD. WE DO HAVE SOMEONE WHO WISHES TO SPEAK ON THIS ITEM. WHAT'S GOING ON, GENEVIEVE? I DON'T HAVE YOU. I'M SORRY? 

DR. GENEVIEVE CLAVREUL: WELL, I JUST ARRIVED. 

SUP. MOLINA, CHAIR: I'M SORRY? 

DR. GENEVIEVE CLAVREUL: I WOULD LIKE TO SPEAK ON THAT ITEM. 

SUP. MOLINA, CHAIR: WELL, YOU'RE NOT-- I DON'T HAVE YOUR CARD. 

DR. GENEVIEVE CLAVREUL: WELL... 

SUP. MOLINA, CHAIR: ON ITEM 50. KAREN OCAMB IS HERE. PLEASE JOIN US. 

KAREN OCAMB: GOOD MORNING. MY NAME IS KAREN OCAMB. I'M HERE TODAY AS HEAD OF THE L.A. SUNSHINE COALITION, WHICH YOU KNOW, I KNOW YOU KNOW BY NOW IS A GROUP OF FIRST AMENDMENT ADVOCATES AND JOURNALISTS, OF WHICH I AM ONE. I STRONGLY, STRONGLY URGE YOU TO RELEASE THE D.H.S. REPORT, ONCE COMPLETE, EVEN IF IT'S REDACTED. PLEASE REMEMBER THAT THESE ALLEGATIONS ARE RAISED IN THE CONTEXT OF AN ALLEGED PATTERN OF INTIMIDATION AND PRESSURE ON COUNTY CONTRACTORS AS WELL AS ALLEGATIONS OF RETRIBUTION AND FAVORITISM REGARDING COUNTY CONTRACTS. PEOPLE WITH H.I.V. AND A.I.D.S. AND A.I.D.S. SERVICE ORGANIZATIONS, AS WELL AS THE PUBLIC, HAVE A RIGHT TO KNOW WHAT D.H.S. HAS FOUND AND WHAT, IF ANYTHING, YOU'RE GOING TO DO ABOUT IT. THIS IS A SERIOUS MATTER. THERE HAVE BEEN-- IT'S A LONG PATTERN OF YOU'RE CREATING THESE KINDS OF REPORTS DEALING WITH THE INDIVIDUAL REPORTS AND THEN BURYING THEM AND GOING ON TO THE NEXT ONE. SO AS YOU HAVE-- AS YOU SAID IN YOUR LAST MEETING, WE'D GREATLY APPRECIATE IT IF, EVEN IF YOU REFER IT TO COUNTY COUNSEL, REFER IT TO THE AUDITOR-CONTROLLER, WHATEVER YOU CAN RELEASE, PLEASE RELEASE. I THINK THAT, ESPECIALLY PEOPLE WITH A.I.D.S. AND A.I.D.S. SERVICE ORGANIZATIONS HAVE A RIGHT TO KNOW WHAT YOU'VE FOUND. THANK YOU VERY MUCH. 

SUP. MOLINA, CHAIR: THANK YOU SO MUCH. NEXT WE HAVE DR. GENEVIEVE CLAVREUL. 

DR. GENEVIEVE CLAVREUL: GOOD MORNING, BOARD OF SUPERVISORS. DR. GENEVIEVE CLAVREUL. I HOPE THAT THIS ITEM WILL NOT DISAPPEAR AND I SECOND WHAT KAREN OCAMB ASKED, THAT WE HAVE A FULL VIEW OF THE AUDITS AND THAT THIS TIME YOU REALLY READ THE REPORT. I MEAN, IN THE PAST, OVER THE LAST FIVE YEARS, YOU HAVE HAD NUMEROUS AUDITS CONDEMNING THE OFFICE OF A.I.D.S. PROGRAM, BOTH FOR THEIR MISREPRESENTATION DURING R.F.P., THREATEN-- I MEAN, IT HAS BEEN NUMEROUS COMPLAINTS, AND I THINK IT'S ABOUT TIME YOU TRULY TAKE ACTION. AND I AM LOOKING FORWARD THIS TIME THAT YOU WILL TAKE ACTION. YOU HAVE THE PERSON IN CHARGE OF O.A.P.P. WHO MISREPRESENT HIS DEGREE, WHO MISREPRESENTED HIMSELF, HE SHOULD HAVE BEEN FIRED ON THE SPOT. HE HAS NOT. HE HAS BEHAVED CONSISTENTLY ON USING HIS POWER TO AFFECT PEOPLE LIVING WITH H.I.V. AND A.I.D.S. AND I THINK IT'S ABOUT TIME YOU DO DO SOMETHING. THANK YOU. 

SUP. MOLINA, CHAIR: THANK YOU. ALL RIGHT. ON ITEM 50, THAT WILL BE REFERRED BACK TO THE DEPARTMENT. MS. BURKE, YOU'RE UP FIRST ON YOUR SPECIALS. 

SUP. BURKE: YES. ON MY ADJOURNMENTS, FIRST, I'D LIKE TO ADJOURN IN MEMORY OF ONIE M. HAYNES. SHE PASSED AWAY FEBRUARY 20TH. SHE WAS AN EMPLOYEE OF THE COUNTY OF LOS ANGELES FOR OVER 37 YEARS. SHE WAS A VALUED EMPLOYEE, WORKING AT THE DEPARTMENT OF ADOPTION FOR FOUR YEARS AND THEN WORKED FOR 33 YEARS AT THE DEPARTMENT OF PUBLIC SOCIAL SERVICES. SHE WAS A LONG-TIME RESIDENT OF THE SECOND DISTRICT. SHE LEAVES TO CHERISH HER MEMORY HER MOTHER, WINNIE, HER CHILDREN, GARY, BRENDA AND DEBORAH AND HER GRANDCHILDREN, BRANDY, CHANEL, JORDAN AND ERIN. GARY WORKS FOR THE LOS ANGELES COUNTY PROBATION DEPARTMENT. I UNDERSTAND HE'S HERE AND WE'D ASK HIM TO STAND. [ APPLAUSE ] 

SUP. BURKE: AND MARY N. SPRIGGS WHO PASSED AWAY ON SUNDAY, MARCH 6TH, IN LAS VEGAS. SHE'S THE BELOVED MOTHER OF REVEREND LEONARD B. JACKSON, WHO RETIRED FROM THE PULPIT AT FIRST A.M.E. CHURCH. WE CERTAINLY ARE GIVING HIM OUR SYMPATHY. AND DR. REGINALD DECAYETTE. HE'S SURVIVED BY HIS WIFE, DOROTHY, AND TWO DAUGHTERS, DR. JACQUELINE DECAYETTE AND SUZANNE DECAYETTE JACKSON. A GRADUATE OF U.S.C. MEDICAL SCHOOL, HE PRACTICED LAW-- PRACTICED MEDICINE AND WAS A RESIDENT OF THE SECOND DISTRICT FOR MANY, MANY YEARS. EDITH ABRAMS, WHO PASSED AWAY YESTERDAY. SHE WAS A LONG-TIME RESIDENT OF THE SECOND DISTRICT FOR 54 YEARS AND A COMMUNITY ACTIVIST. SHE WAS ONE OF THE ORIGINAL MEMBERS OF GRANDMA'S HANDS, ONE OF THE OLDEST COMMUNITY SERVICE ORGANIZATIONS IN THE SECOND DISTRICT. SHE ALSO SERVED ON THE BOARD FOR THE BRAILLE INSTITUTE AND ON THE MARTIN LUTHER KING ADVISORY BOARD. SHE'S SURVIVED BY HER DAUGHTER, PERCENIA BEASLEY, AND A NIECE, THELMA KNOX. EDITH WAS AT EVERY MEETING AND EVERY ONE OF OUR HEARINGS. SHE WAS ALWAYS ACTIVE AND VERY CONCERNED ABOUT THE COUNTY AND CERTAINLY ABOUT KING DREW MEDICAL CENTER. AND CINDERELLA "CINDY" HAMPTON- BLACKMAN, LONG-TIME RESIDENT OF THE SECOND DISTRICT. SHE WAS A MEMBER OF GREATER FIRST BAPTIST CHURCH, WHERE SHE SERVED IN MANY CAPACITIES. SHE LEAVES TO CHERISH HER HUSBAND OF 42 YEARS, ARNOLD BLACKMAN, AND TWO WONDERFUL CHILDREN, KAREN AND CORDELL, WHO ARE TWINS. 

SUP. MOLINA, CHAIR: THOSE ARE ALL OF YOUR ADJOURNMENTS? 

SUP. BURKE: THOSE ARE ALL OF MY ADJOURNMENTS AND, ACTUALLY, I WASN'T HOLDING ANYTHING. 

SUP. MOLINA, CHAIR: ALL RIGHT. SO ORDERED ON THOSE ADJOURNMENTS. SUPERVISOR YAROSLAVSKY, YOUR SPECIALS. 

SUP. YAROSLAVSKY: MADAM CHAIR, FIRST OF ALL, I'D LIKE TO ASK THAT WE ADJOURN-- WE SAW IN THE PAPER THIS MORNING THE PASSING OF SERGIU COMISSOINA, WHO IS THE PRINCIPAL GUEST CONDUCTOR OF THE U.S.C. THORNTON SYMPHONY AND ALSO OF THE JERUSALEM SYMPHONY AND A NUMBER OF OTHER ORCHESTRAS AROUND THE WORLD WITH WHICH HE WAS ASSOCIATED. I HAD THE PLEASURE OF SEEING HIM CONDUCT ON A NUMBER OF OCCASIONS AT BOVARD AUDITORIUM. HE PASSED AWAY SUDDENLY OF A HEART ATTACK WHILE ON TOUR AND WE'LL GET THE BOARD SECRETARY THE INFORMATION, WHICH I DON'T HAVE AT THE PRESENT TIME. 

SUP. KNABE: I'D LIKE TO BE ON THAT AS WELL. 

SUP. YAROSLAVSKY: OKAY. ALL MEMBERS. 

SUP. MOLINA, CHAIR: SO ORDERED ON THAT ADJOURNMENT. 

SUP. YAROSLAVSKY: ON THE ITEM RELATING TO NO SMOKING ON BEACHES, I THINK MR. KNABE HAD AN AMENDMENT. 

SUP. MOLINA, CHAIR: ON WHICH ITEM? 

SUP. YAROSLAVSKY: I DON'T KNOW THE NUMBER-- NUMBER 2, SO I'LL CALL THAT UP AND YIELD TO MR. KNABE. 

SUP. KNABE: I JUST WOULD LIKE TO CALL STAN WISNIEWSKI FORWARD TO SORT OF GIVE US A BRIEF-- BRIEFING ON THE OUTCOME OF THE TEMPORARY BAN THAT WE HAD. STAN, CAN YOU JUST GIVE US A BRIEF? WERE THERE ANY PROBLEMS, HOW DID THE-- HOW DID THINGS WORK OUT? WHAT WERE THE IMPACT ON LIFEGUARDS, SHERIFFS, ANYTHING LIKE THAT. 

STAN WISNIEWSKI: SURE. SUPERVISOR, THE ORDINANCE WAS IN EFFECT FOR A VERY SHORT PERIOD OF TIME, JUNE 22 TO SEPTEMBER 16 OF '04. THE SHERIFF'S DEPARTMENT DID NOT CITE ANYONE. IT WAS MORE OF A VOLUNTARY, IF THEY SAW SOMEONE SMOKING AND THAT WAS TYPICALLY AT TOPANGA, THEY... 

SUP. ANTONOVICH: CAN'T HEAR YOU. 

STAN WISNIEWSKI: IF THEY SAW SOMEONE SMOKING, THE SHERIFF'S DEPARTMENT, IF THEY SAW SOMEONE SMOKING, AND TYPICALLY THAT WAS AT TOPANGA, THEY WOULD ADVISE THAT THERE WAS A BAN ON SMOKING AND THAT WAS RECEIVED WELL BY THE PUBLIC. NO ONE, FROM WHAT WE UNDERSTAND, BECAME ARGUMENTATIVE. THE LIFEGUARDS HAD A NUMBER OF INQUIRIES, BOTH, I THINK, AT TOPANGA AS WELL AS AT MOTHER'S BEACH AND MARINA DEL REY. I THINK THE ORDINANCE WAS FAIRLY WELL RECEIVED IN TERMS OF THE IMPACT ON MAINTENANCE. IT'S REALLY TOO SOON TO TELL IF IT'S GOING TO HAVE AN APPRECIABLE IMPACT ON REDUCING CIGARETTE BUTTS ON THE BEACH BUT-- GIVEN THAT THEY COME FROM OTHER SOURCES. BUT, OVERALL, WE DID TALK TO THE LIFEGUARD, THE FIRE CHIEF, WHO ENDORSED OUR RECOMMENDATION FOR A PERMANENT BAN. WE ALSO TALKED TO HEALTH SERVICES, WHO SUPPORTS US. WE HAVE NOT RECEIVED A COMMENT BACK FROM THE SHERIFF'S DEPARTMENT, ALTHOUGH WE UNDERSTAND THAT THE IMPACT ON BOTH LIFEGUARDS AND THE SHERIFF WAS RELATIVELY MINIMAL. 

SUP. KNABE: OKAY. THANK YOU. THE AMENDMENT I HAVE IS JUST BASICALLY, AS STAN INDICATED, IT'S A LITTLE TOO EARLY TO TELL ON SOME OF THESE THINGS, AND WE KNOW THAT, IF THERE'S ENFORCEMENT ISSUES, THEY'RE GOING TO BE RUNNING TO LIFEGUARDS TO POSSIBLY DISTRACT THEM AND WE DON'T KNOW WHAT ALL THOSE ISSUES MAY BE AND I WOULD JUST ASK, AS AN AMENDMENT TO ZEV'S MOTION, THAT WE REQUEST THAT THE SHERIFF AND FIRE CHIEF REPORT BACK IN NINE MONTHS ON THE ENFORCEMENT ACTIVITIES OF THE ORDINANCE SO WE JUST HAVE A LITTLE BIT BETTER HANDLE ON IT. 

SUP. YAROSLAVSKY: I'LL SECOND THAT. I HAVE NO PROBLEM. 

SUP. MOLINA, CHAIR: BUT YOU'RE MOVING FORWARD THAT WE... 

SUP. KNABE: RIGHT. 

SUP. MOLINA, CHAIR: ...APPROVE THE PERMANENT BAN? 

SUP. KNABE: RIGHT. AND JUST REPORTING BACK IN NINE MONTHS ON THE ENFORCEMENT ISSUES AND, YOU KNOW, ANY STAFFING ISSUES THAT MIGHT BE RELATED. 

SUP. YAROSLAVSKY: AND THAT WILL BE AFTER THE SUMMER, SO IT WILL BE PERFECT TIMING. 

SUP. KNABE: RIGHT. SO THAT'LL GIVE US A BETTER HANDLE... 

SUP. MOLINA, CHAIR: SO IT'S FURTHER EVALUATION OF ENFORCEMENT? 

SUP. KNABE: RIGHT. THE ENFORCEMENT SIDE, WE'RE MOVING FORWARD WITH THE PERMANENT BAN. 

SUP. MOLINA, CHAIR: WITH THE PERMANENT BAN. ALL RIGHT. I WANT TO HAVE A CLEAR UNDERSTANDING. I THINK THE REPORT WAS VERY SKETCHY BUT THERE PROBABLY BE A PATTERN DEVELOPED. NOW, THERE ARE ABOUT 10 PEOPLE THAT WISH TO ADDRESS US ON THIS ITEM, ALL SUPPORTING A PERMANENT BAN. I DON'T KNOW IF THERE'S ANY OBJECTION HERE. ARE YOU STILL INTERESTED IN ADDRESSING THIS ITEM? NO OBJECTION? ALL RIGHT. 

SUP. YAROSLAVSKY: MADAM CHAIR, PERHAPS YOU CAN JUST ACKNOWLEDGE THE PEOPLE? 

SUP. MOLINA, CHAIR: I'D LOVE TO CALL THE NAMES. ROBERT DONIN, WHO REPRESENTS THE TRIPACK HEALTH AND WELLNESS ADVOCACY IS HERE TO SUPPORT A PERMANENT BAN. ROBERT BERGER FROM L.A. COUNTY SMOKE-FREE BEACH TASK FORCE IS HERE TO SUPPORT A PERMANENT BAN. ERICK BATCH FROM THE AMERICAN HEART ASSOCIATION IS ALSO HERE TO SUPPORT A PERMANENT BE BAND. JESSICA STEFAN, SURFSIDE FOUNDATION OF MALIBU CHAPTERS IS ALSO HERE. STEPHEN GALLEGOS ALSO SUPPORTS A SMOKE-FREE BEACH ORDINANCE. LORI LUDLOW IS ALSO IN SUPPORT, AS I UNDERSTAND. SONYA VASQUEZ, WHO IS WITH THE GIRLS CLUB OF LOS ANGELES IS IN SUPPORT. MARTIN BARRERA MARTINEZ, FROM THE AMERICAN CANCER SOCIETY, HAS ALSO JOINED US HERE IN SUPPORT OF A PERMANENT BAN. AND DAVID R. PRUITT FROM THE LOS ANGELES COUNTY MEDICAL ASSOCIATION IS ALSO HERE. SO IF THERE IS NO OBJECTION, LADIES AND GENTLEMEN... 

SUP. YAROSLAVSKY: I'LL MOVE IT. 

SUP. MOLINA, CHAIR: IT IS MOVED, IT IS SECONDED AS AMENDED, AND THERE'S NO OBJECTION. WE NOW HAVE A PERMANENT BAN AT OUR L.A. COUNTY BEACHES, NO SMOKING. [ APPLAUSE ] 

SUP. YAROSLAVSKY: THANK YOU ALL FOR YOUR PATIENCE AND FOR COMING DOWN. MADAM CHAIR, I HAVE ONE... 

SUP. MOLINA, CHAIR: ONE LAST THING. WE JUST HAVE TO HAVE THE RELATED ORDINANCE HAS TO BE READ BY THE EXECUTIVE OFFICER. 

CLERK VARONA-LUKENS: FOR THE RECORD, THAT'S AN ORDINANCE FOR ADOPTION AMENDING TITLE 11, HEALTH AND SAFETY OF THE LOS ANGELES COUNTY CODE, ADDING SUBSECTION "G" TO SECTION 11.64.030 TO BAN SMOKING ON PUBLIC BEACHES, EXCLUSIVE OF PUBLIC PARKING AREAS. 

SUP. MOLINA, CHAIR: VERY GOOD. THAT ORDINANCE IS MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR KNABE. IF THERE'S NO OBJECTION, SO ORDERED. ALL RIGHT. THAT ITEM IS COMPLETE. 

SUP. YAROSLAVSKY: MADAM CHAIR, I HAVE ONE OTHER ADJOURNING MOTION I FAILED TO READ AND THAT'S LAST TUESDAY, A LONG-TIME FRIEND OF MINE-- MY FAMILY, MY PARENTS, ACTUALLY, SIDNEY EISENSTAD PASSED AWAY. SID WAS A VERY SUCCESSFUL AND PROMINENT ARCHITECT IN LOS ANGELES. HE WAS THE ARCHITECT WHO DESIGNED THE FRIARS CLUB IN BEVERLY HILLS, TEMPLE EMMANUEL IN BEVERLY HILLS, SINAI TEMPLE IN WEST LOS ANGELES, THE KNOX PRESBYTERIAN CHURCH HERE IN LOS ANGELES AND HAD-- DID A NUMBER OF RELIGIOUS INSTITUTIONS AROUND THE COUNTRY. HE WAS VERY ACTIVE IN JEWISH EDUCATION, WAS A MEMBER AND LEADER IN THE BUREAU OF JEWISH EDUCATION, WHICH OVERSAW THE ENTIRE JEWISH SCHOOL SYSTEM HERE IN LOS ANGELES FOR MANY YEARS. HE WAS ACTIVE IN VARIOUS ASPECTS OF THE JEWISH AND GENERAL COMMUNITY AS WELL. AND HE IS SURVIVED BY HIS DAUGHTERS, TWO DAUGHTERS, CAROL OKEN AND ABBEY ROBIN. SID, SINCE THIS IS ELECTION DAY IN THE CITY OF LOS ANGELES, SID, FOR ALL OF HIS OTHER GREAT ASSETS, THE ONE ASSET HE WILL ALWAYS BE REMEMBERED FOR BY ME IS HIS FRONT LAWN ON MOTOR AVENUE, WHICH HAD MY LAWN SIGN ON IT WHEN I FIRST RAN, THOSE ARE PRIZED FRONT LAWNS. AND SID, FROM 1975 ON, WAS ALWAYS-- ALWAYS HAD A RESERVED SPOT FOR MY LAWN SIGNS. HE WAS A WONDERFUL HUMAN BEING, AND IT'S A GREAT PERSONAL LOSS AND A LOSS TO THE COMMUNITY. THAT'S ALL I HAVE, MADAM CHAIR. 

SUP. MOLINA, CHAIR: ALL RIGHT. SO ORDERED ON THAT ADJOURNMENT. BEFORE I CALL ON SUPERVISOR KNABE, WE DO HAVE TWO SET ITEMS AND-- AT 11:00 AND I'D LIKE TO CALL UP THE FIRST ONE, WHICH IS A REPORT BY PUBLIC HEALTH ON THE STATUS AND THE PREPARATIONS FOR THE WEST NILE VIRUS IN LOS ANGELES. IF I COULD HAVE DR. FIELDING AND OTHERS JOIN US, I'D APPRECIATE IT. 

JONATHAN FIELDING: GOOD MORNING, MADAM CHAIR AND SUPERVISORS, I'M JONATHAN FIELDING, DIRECTOR OF PUBLIC HEALTH AND DEPARTMENT OF HEALTH SERVICES. AND LET ME GIVE BOTH THE EXPERIENCE WE'VE HAD TO DATE AND WHAT WE'RE PLANNING. WEST NILE IS A VIRUS THAT'S WIDELY DISTRIBUTED IN OTHER CONTINENTS, FIRST APPEARED IN NORTH AMERICA IN THE NEW YORK AREA IN 1999. IT IS TRANSMITTED TO HUMANS THROUGH MOSQUITOS BITING INFECTED BIRDS AND THERE ARE MANY SPECIES OF BIRDS THAT CAN CARRY THE VIRUS. ABOUT 80%, FOUR OUT OF FIVE, OF THOSE WHO GET WEST NILE DON'T HAVE ANY SYMPTOMS OR THEY ARE SO MILD, IT'S NOT NOTICED. 20% HAVE WEST NILE FEVER WITH FEVER, HEADACHE, BODY ACHES, NAUSEA AND VOMITING AND SOMETIMES SWOLLEN GLANDS OR A SKIN RASH AND THESE SYMPTOMS CAN GO ON FOR DAYS, WEEKS AND SOMETIMES EVEN MONTHS. ABOUT ONE IN 150 GET NEURO-INVASIVE DISEASE. THAT IS INFLAMMATION OF THE BRAIN, ENCEPHALITIS, OR MENINGITIS, WHICH IS INFLAMMATION OF THE MEMBRANES AROUND THE BRAIN AND THE SPINAL CORD. AND, IN THOSE SITUATIONS, YOU CAN HAVE, IN ADDITION TO FEVER AND HEADACHE, STIFF NECK WITH ENCEPHALITIS, PARTICULARLY. YOU CAN ALSO GET ALTERATION OF CONSCIOUSNESS. THAT CAN PROGRESS TO CONFUSION, COMA AND WE CAN RARELY GET A POLIO-LIKE ILLNESS WITH A PARALYSIS WITHOUT LOSS OF SENSATION. THERE WERE SEVEN CASES OF THAT LAST YEAR. THIS MOVED AROUND THE COUNTRY. WE HAD OUR FIRST LOCALLY ACQUIRED CASE IN 2003. IN 2004, WE HAD OUR FIRST DEAD CROWS IN FEBRUARY WITH WEST NILE VIRUS. IN EARLY JULY, WE HAD POSITIVE MOSQUITO POOLS AND CROWS CONTINUED AND, IN JUNE, WE HAD OUR FIRST HUMAN CASE. THERE WERE A TOTAL OF 306 CASES REPORTED DURING 2004 WITH 190 HOSPITALIZATIONS. THERE ARE, OF COURSE, MANY CASES OF AN APPARENT INFECTION BECAUSE IT'S USUALLY NOT TESTED UNLESS SOMEBODY HAS SEVERE SYMPTOMS. OF THESE 306 CASES, 139 WERE NEURO-INVASIVE AND THERE WERE 13 DEATHS. THE DEATH RATE IS ABOUT ONE OUT OF 10 IN THOSE WHO HAVE NEURO-INVASIVE DISEASE. THERE WERE 23 FROM BLOOD DONORS BUT NOW ALL THE BLOOD IS BEING SCREENED. IN TERMS OF THE LIKELIHOOD, THOSE OVER 50 ARE MORE LIKELY TO GET NEURO-INVASIVE DISEASE. THE MALE/FEMALE RATIO IS ABOUT 1.8-TO-1 PERHAPS BECAUSE MEN SPEND MORE TIME IN OUTSIDE ACTIVITIES. THERE HAVE BEEN DEAD BIRDS FOUND IN ALMOST ALL PARTS OF LOS ANGELES COUNTY AND HUMAN CASES IN ALL THE SPAS BUT MOST HEAVILY CONCENTRATED IN SAN GABRIEL, SAN FERNANDO VALLEYS, AND THE EASTERN SPA. WE HAVE BEEN WORKING CLOSELY WITH VECTOR CONTROL AGENCIES AND ENGAGED IN A LARGE PUBLIC CAMPAIGN WITH KEY MESSAGES THROUGH NEWS RELEASES, PRESS CONFERENCES, SPECIAL PROMOTION EVENTS, COMMUNITY OUTREACH, PARTICULARLY WITH PRESENTATION TO COMMUNITY GROUPS, I THINK THERE WERE ABOUT 172 THAT WERE PROVIDED LAST YEAR AND MANY LECTURES TO PHYSICIANS AND HOSPITAL GROUPS. WE ALSO WORKED WITH CITIES AND THEIR PARKS AND RECREATION SERVICES. WE DID A SURVEY LAST FALL TO FIND OUT WHAT THE LOS ANGELES POPULATION KNEW AND WHAT THEY THOUGHT ABOUT IT. WE DID IT BOTH IN ENGLISH AND SPANISH. 93% HAD HEARD OF WEST NILE VIRUS, THEY UNDERSTOOD THAT IT'S TRANSMITTED THROUGH MOSQUITOS, ABOUT 97%. MOST PEOPLE GOT THEIR INFORMATION FROM T.V., NOT SURPRISINGLY, ABOUT TWO OUT OF THREE. OTHERS GOT IT FROM NEWSPAPERS, MAGAZINES AND RADIO. SIX OUT OF 10 RESIDENTS IN LOS ANGELES COUNTY INDICATE THAT THEY WERE VERY OR SOMEWHAT CONCERNED ABOUT GETTING WEST NILE. ONE THIRD SAID THEY HAD MOSQUITOS AROUND THEIR HOUSE AND THREE OUT OF FOUR TOOK SOME ACTION TO TRY AND REDUCE THEIR RISK. HOWEVER, MOST SIGNIFICANTLY, ONLY 18% SAID THEY USED MOSQUITO REPELLENT ALL OR MOST OF THE TIME. WE'VE PROVIDED YOU A SUMMARY OF OUR PLAN FOR 2005. I MIGHT ADD THAT, SO FAR, WE'VE HAD TWO POSITIVE DEAD BIRDS FOR WEST NILE AND ONE HUMAN CASE, ALTHOUGH WE'RE NOT SURE WHETHER THAT CASE ACTUALLY STARTED IN THIS YEAR OR POSSIBLY THE END OF LAST YEAR. OUR PLAN INCLUDES SURVEILLANCE, HUMAN SURVEILLANCE, SURVEILLANCE FOR BIRDS AND MOSQUITOS. WE ARE PARTICULARLY CONCERNED ABOUT CORVEDS, WHICH ARE CROWS, RAVENS, MAGPIES AND ALSO RAPTORS, WHICH ARE HAWKS AND OWLS. THEIR VECTOR CONTROL IS, OUR PARTNERS IN THIS, ARE TESTING A HUNDRED MOSQUITO POOLS PER WEEK, THERE ARE SENTINEL CHICKEN FOX AND OF COURSE VECTOR CONTROL AGENCIES DO A VERY GOOD JOB WITH LARVICIDES, WITH MOSQUITO FISH, AND TRYING TO ELIMINATE THE HABITAT WHERE MOSQUITOS CAN BREED AND RARELY BUT ON SOME OCCASIONS, THEY'RE SPRAYING IN SOME LIMITED SITUATIONS FOR ADULT MOSQUITOS. WE DO CASE FOLLOW-UP, WE COORDINATE CLOSELY WITH VECTOR CONTROL, WE DO TESTING IN OUR PUBLIC HEALTH LABORATORY, WE UPDATE REPORTS ON AT LEAST A WEEKLY BASIS AND WE HAVE FOCUSED ON THE HEALTH EDUCATION MESSAGES BASED ON THE RESULTS OF OUR SURVEY. AND ONE KEY MESSAGE IS WEST NILE VIRUS PREVENTION BEGINS IN YOUR OWN BACKYARD. SO OUR FOCUS NOW HAS BEEN REMOVING STAGNANT WATER. WITH THE HEAVY RAINS WE'VE HAD, THERE ARE MORE PLACES WHERE THERE IS WATER THAN USUALLY. THAT PROVIDES, COMBINED WITH HOTTER WEATHER THAT WE NOW EXPERIENCE, AN OPPORTUNITY FOR MOSQUITO BREEDING. WE'RE FOCUSING ON PROTECTING ONE'S SELF AND ONE'S FAMILY. WE PLAN TO DO THIS THROUGH NEWS CONFERENCES AND RELEASE, COORDINATED WITH VECTOR CONTROL AGENCIES LOCALLY AND WITH THE STATE. WE'LL DO PROMOTIONAL EVENTS, DEPENDING ON WHAT WE FIND WHEN. WE HAVE INFORMATIONAL CARDS GOING TO HEALTH CENTERS, PARKS, SCHOOL DISTRICTS, SENIOR CENTERS, HOME IMPROVEMENT CENTERS, ET CETERA, ET CETERA. WE HAVE BROCHURES THAT PARK AND REC IS DISTRIBUTING. THERE'S A TOLL FREE PUBLIC INFORMATION LINE IN MULTIPLE LANGUAGES. ALL OUR MATERIALS ARE IN ENGLISH AND SPANISH AND, IN ADDITION, WE HAVE SOME MATERIALS IN FIVE OTHER LANGUAGES. AS I MENTIONED, WE GAVE 172 COMMUNITY PRESENTATIONS IN 2004. THE QUESTION THAT WE MOST OFTEN GET ASKED IS, HOW BAD WILL IT BE THIS YEAR? IT IS IMPOSSIBLE TO PREDICT BUT WE NEED TO PREPARE AS IF IT WILL BE A HEAVY SEASON. CERTAINLY, THE RECENT WEATHER FAVORS THE INCREASE IN MOSQUITO POPULATION. HOWEVER, MANY PLACES WITH WEST NILE VIRUS SEE A DECREASE IN BIRDS IN YEAR 2 AND THEREAFTER AND THERE IS AT LEAST QUALITATIVE INFORMATION SUGGESTING THERE MAY BE FEWER HOSTS. SO THE INITIAL FOCUS IS ON HABITAT ELIMINATION AND EVERY RESIDENT CAN MAKE A DIFFERENCE. I'D BE HAPPY TO ANSWER ANY QUESTIONS. WE'RE ALSO JOINED, LET ME JUST ADD, BY JACK HAZELRIG, WHO IS THE MANAGER OF GREATER L.A. VECTOR CONTROL AND STEVE WEST, MANAGER OF SAN GABRIEL VALLEY VECTOR CONTROL. THEY DO A WONDERFUL JOB AND THEY'RE HERE TO ANSWER QUESTIONS IF I CAN'T. 

SUP. MOLINA, CHAIR: ALL RIGHT. SUPERVISOR KNABE? 

SUP. KNABE: YEAH. THE QUESTION I HAVE, WHEN WE'RE OUT AND AROUND IN OUR DISTRICTS OR AT LEAST IN MY DISTRICT AND VISITING A LOT OF DIFFERENT GROUPS AND ORGANIZATIONS, PARTICULARLY THE SENIORS, YOU KNOW, IT APPEARS, IN ALL THE PUBLICATIONS, THAT ANYONE OVER 50 AND PARTICULARLY THE FRAIL ARE PARTICULARLY VULNERABLE AND, YOU KNOW, HAVE A TENDENCY TO, YOU KNOW, HAVE REAL PROBLEMS WITH IT. SO, IN ADDITION, JUST THE NORMAL KINDS OF THINGS. IS THERE A SPECIFIC-- I MEAN, WHAT ARE YOU DOING FOR EDUCATIONAL OUTREACH AS IT RELATES TO THOSE? INSTEAD OF JUST THE GENERIC, YOU KNOW, SHOTGUN APPROACH TO LETTING EVERYONE KNOW, WHICH WE DO NEED TO DO, ARE THERE PARTICULAR EFFORTS OUT THERE TO PROTECT SENIORS AND THE FRAIL FROM THIS WHOLE ISSUE OR EDUCATE THEM? 

DR. JONATHAN FIELDING: YES, SUPERVISOR. WE ARE PROVIDING A SPEAKER'S BUREAU. WE GO OUT AND TALK TO SENIOR GROUPS. WE GO OUT AND TALK TO SENIOR CENTERS. WE HAVE PEOPLE AVAILABLE IN EACH OF THE SUPERVISORIAL DISTRICT DISTRICTS, IN EACH OF OUR SPAS WHO ARE AVAILABLE TO DO THAT, WHO HAVE BEEN SPECIALLY TRAINED. WE HAVE STOCK PRESENTATIONS, BOTH IN ENGLISH AND SPANISH. WE HAVE PEOPLE WHO HAVE BEEN TRAINED TO BE ABLE ANSWER THE MORE COMPLICATED QUESTIONS IN DOING THAT. IN ADDITION, WE DISTRIBUTE THINGS THROUGH LIBRARIES, THROUGH PARK AND REC THAT ARE SPECIFIC MATERIALS. SO WE ARE WORKING TO PROVIDE AS MUCH OUTREACH AS POSSIBLE. 

SUP. KNABE: YEAH, BECAUSE PARTICULARLY SOME OF THE FRAIL ARE CONFINED TO THEIR HOMES AS WELL, TOO, SO IT'S IMPORTANT THEY GET THE INFORMATION AS WELL. I DON'T KNOW THROUGH THE IN-HOME SUPPORTIVE SERVICES OR SOME OTHER OUTREACH THAT, YOU KNOW, THOSE THAT AREN'T ABLE TO GO TO A SENIOR CENTER TO HEAR A PRESENTATION OR GO TO A COMMUNITY MEETING, OBVIOUSLY, IN THAT POPULATION, THERE ARE OTHER ISSUES SO... 

DR. JONATHAN FIELDING: WE'RE HAPPY TO WORK WITH ALL THOSE AGENCIES AND GIVE MATERIALS TO HOME HEALTH AGENCIES, HOME CARE AGENCIES. I WOULD ADD THOUGH THAT PEOPLE CAN FIND... 

SUP. KNABE: I WAS THINKING OF THINGS LIKE-- WELL, I WAS THINKING OF THINGS LIKE, IS THERE ABILITY TO GET THE INFORMATION, SAY, TO THE MEALS ON WHEELS PROGRAMS AND WITH THEIR MEAL, THAT THEY GET A THING ON THE WEST NILE. 

SUP. MOLINA, CHAIR: IT WOULD BE A GOOD WAY TO LEVERAGE COMMUNICATION. 

DR. JONATHAN FIELDING: SURE. WE WOULD-- I CAN'T TELL YOU IF WE DID THAT LAST YEAR BUT WE CERTAINLY CAN DO THAT THIS YEAR. I JUST WOULD-- ONE OTHER THING, THOUGH, THAT HOMEBOUND PEOPLE ARE AT MUCH LOWER RISK AND ONE OF THE KEY MESSAGES WE TELL PEOPLE IS MAKE SURE YOUR SCREENS ARE IN PLACE SO YOU DON'T HAVE MOSQUITOS IN YOUR HOME. 

SUP. KNABE: WELL, WE HAD, YOU KNOW, THE TWO DEATHS IN LONG BEACH, YOU KNOW, THEY WERE AT HOME, SO... 

DR. JONATHAN FIELDING: WELL, YEAH, THAT'S ABSOLUTELY RIGHT. THAT'S ABSOLUTELY RIGHT, SUPERVISOR. 

SUP. KNABE: OKAY. THANK YOU. 

SUP. MOLINA, CHAIR: DO YOU DO ANY-- ARE YOU DOING ANY PUBLIC SERVICE MESSAGES AS WELL ON CABLE OR OTHERS TO LET PEOPLE KNOW ABOUT THIS? 

DR. JONATHAN FIELDING: WE HAVE PUBLIC SERVICE MESSAGES AVAILABLE AND OUR EXPERIENCE HAS BEEN THAT PEOPLE REALLY DON'T START LISTENING UNTIL WE HAVE, YOU KNOW, A SIGNIFICANT NUMBER OF HUMAN CASES. LAST YEAR, OUR FIRST CASE WAS IN JUNE. THE ONLY CASE WE'VE REPORTED THUS FAR THIS YEAR, WE'RE NOT SURE IF IT STARTED THIS YEAR OR LAST OR THE END OF LAST SEASON BECAUSE OF THE BLOOD WORK. SO, AS SOON AS WE START HAVING SIGNIFICANT NUMBER OF CASES, WE WILL TRY AND GET OUR PUBLIC SERVICE ANNOUNCEMENTS ON. WE'LL BE HOLDING PRESS CONFERENCES AND OTHER PROMOTIONAL EVENTS AT LARGE VENUES TO TRY AND GET THE MESSAGE. 

SUP. MOLINA, CHAIR: SUPERVISOR ANTONOVICH. 

SUP. ANTONOVICH: DR. FIELDING, WHEN WILL THE PUBLIC HEALTH SPEAKERS BUREAU BEGIN THE MEETINGS, TRAININGS, FUNCTIONS WITH THE TOWN COUNCILS AND OTHER COMMUNITY ORGANIZATIONS? 

DR. JONATHAN FIELDING: IT'S READY. I THINK, GENERALLY, WE WOULD START THIS ABOUT THE FIRST OF APRIL OR SO BECAUSE THAT'S WHEN WE USUALLY START SEEING AN INCREASE IN DEAD BIRDS AND POSITIVES. IF WE DO IT TOO EARLY, PEOPLE JUST DON'T THINK ABOUT IT. BUT I THINK WE'RE PREPARED TO MEET THE DEMAND AND WE WOULD START OFFERING THEM, IF SOMEBODY WANTED IT NOW, WE'D BE HAPPY TO DO IT BUT WE'D MORE PROACTIVELY OFFER IT STARTING AROUND THE 1ST OF APRIL. 

SUP. ANTONOVICH: HOW WILL WE NOTIFY OUR PARKS AND RECREATIONAL DEPARTMENT TO BE INFORMED, ALONG WITH ENGAGING THE OTHER INDEPENDENT CITIES, PARKS AND RECREATION DEPARTMENTS? 

DR. JONATHAN FIELDING: WE HAVE A SPECIAL BROCHURE THAT'S BEING DISTRIBUTED BY PARKS AND REC, BY COUNTY PARKS AND REC THAT IS COMPREHENSIVE. IN ADDITION, WE HAVE DONE TRAINING FOR OTHER CITY PARKS AND REC, FOR OTHER CITY PARKS AND REC AGENCIES AND PROVIDE MATERIAL TO THEM. 

SUP. ANTONOVICH: WILL THE U.S. FOREST SERVICE AND COUNTY PUBLIC WORKS AND THE AGRICULTURAL COMMISSION DIRECTOR OF WEIGHTS AND MEASURES ARRANGE ADDITIONAL TRAINING SESSIONS? 

DR. JONATHAN FIELDING: WE'RE HAPPY TO ARRANGE SESSIONS FOR THEM. I CAN'T TELL YOU WHAT THEIR INDIVIDUAL PLANS ARE. 

SUP. ANTONOVICH: WHAT EFFORTS ARE GOING TO BE MADE BY THE VECTOR MANAGEMENT PROGRAM TO DISTRIBUTE LITERATURE TO CITY AND UNINCORPORATED COMMUNITIES? 

DR. JONATHAN FIELDING: WELL, THE VECTOR CONTROL AGENCIES ARE HERE AND CAN SPEAK FOR THEMSELVES BUT WE'VE COORDINATED CLOSELY WITH THEM AND HAVE DEVELOPED MATERIALS, AS HAVE THEY, AND THEY, OF COURSE, WORK CLOSELY WITH THE CITIES IN THEIR DISTRICTS. 

SUP. ANTONOVICH: I KNOW LAST YEAR, WE HAD RECEIVED REPORTS THAT THE VECTOR UNIT DID NOT RESPOND IN A TIMELY MANNER. HAS THAT BEEN CORRECTED? 

DR. JONATHAN FIELDING: I THINK VECTOR CONTROL, IN GENERAL, HAS DONE A VERY GOOD JOB. MANY PEOPLE THINK THAT THE NUMBER OF CASES WE HAD LAST YEAR IS MUCH LESS THAN WE COULD HAVE REASONABLY EXPECTED, GIVEN THE EXPERIENCE IN OTHER PARTS OF THE COUNTRY. SO THE COORDINATION, I THINK, IS CLOSER. ARE THERE SOMETIMES GLITCHES? YEAH. BUT I THINK THAT, OVERALL, THE COORDINATION IS QUITE CLOSE. 

SUP. ANTONOVICH: IF A DEAD CROW FOUND IN A PARTICULAR AREA AND THERE'S SUCH A BIRD, WHY DOESN'T THE VECTOR CONTROL GO OUT AND CHECK THE PROBLEM AFTER THE FIRST BIRD IS IDENTIFIED IN THAT PARTICULAR CITY? 

DR. JONATHAN FIELDING: WELL, I THINK VECTOR CONTROL DOES. THEY ARE LOOKING VERY HARD FOR HABITAT. THEIR FOCUS IS ON MAKING SURE THERE AREN'T SOURCES OF STANDING WATER. OF COURSE, ONE OF THE PROBLEMS IS THAT, JUST BECAUSE A BIRD DIES IN A PARTICULAR AREA, IT HAS QUITE A RANGE. SO, IN FACT, IT DOESN'T MEAN THAT PEOPLE RIGHT IN THAT AREA ARE AT GREATER RISK THAN PEOPLE, LET'S SAY, 10 MILES AWAY. 

SUP. ANTONOVICH: IT WAS REPORTED LAST YEAR THAT THE INFECTION IN ANIMALS WERE IDENTIFIED IN BIRDS AND HAS SHOWN TO INFECT HORSES, CATS, BATS, CHIPMUNKS, SKUNKS, SQUIRRELS AND DOMESTIC RABBITS. WHERE DOES A PERSON CALL IN THE EVENT THAT THIS OCCURS? 

DR. JONATHAN FIELDING: YOU'RE ABSOLUTELY RIGHT, SUPERVISOR, IT CAN OCCUR IN OTHER SPECIES. THERE IS A VACCINE FOR HORSES. IT CAN AFFECT DOMESTIC ANIMALS BUT THE CHANCES OF IT BEING DIAGNOSED IS QUITE RARE BECAUSE THAT'S NOT SOMETHING IN GENERAL THAT'S LOOKED AT AND WE'VE NOT RECEIVED ANY REPORTS OF THOSE CASES. CERTAINLY, OUR VETERINARIAN HEALTH UNIT WOULD BE HAPPY TO RESPOND IF THERE WAS SUCH A REPORT. 

SUP. ANTONOVICH: SO THE HOTLINE NUMBER OF 1-877-747-2243 IS AVAILABLE TO MAKE THOSE TYPES OF REPORTS FROM THE PUBLIC? 

DR. JONATHAN FIELDING: THAT IS A STATE HOTLINE NUMBER FOR DEAD BIRDS. I DON'T KNOW, SUPERVISOR, WHAT THEY WOULD DO. THEY WOULD PROBABLY REFER IT EITHER TO THEIR VETERINARIAN HEALTH UNIT OR TO OURS IF THEY HAD A REPORT OF ANOTHER SPECIES... 

SUP. ANTONOVICH: SO THEY'D BE ABLE TO REFER THEM IF THEY CALLED THAT NUMBER? 

DR. JONATHAN FIELDING: YES, EXACTLY. 

SUP. ANTONOVICH: THANK YOU. 

SUP. MOLINA, CHAIR: ANY OTHER QUESTION OR COMMENT? IF NOT, THANK YOU SO MUCH, DR. FIELDING, FOR YOUR REPORT. 

DR. JONATHAN FIELDING: YOU'RE WELCOME. 

SUP. ANTONOVICH: RECEIVE AND FILE? 

SUP. MOLINA, CHAIR: WE'LL RECEIVE AND FILE THAT ITEM, IF THERE'S NO OBJECTION. ALL RIGHT. SUPERVISOR KNABE, WE'RE READY FOR YOUR SPECIALS. 

SUP. KNABE: THANK YOU, MADAM CHAIR. IT CAME TO MY ATTENTION THIS MORNING, I'M GOING TO ADJOURN IN MEMORY OF JENNIFER CHOPPIN FITZGERALD. JENNIFER PASSED AWAY ON FRIDAY. SHE WAS ONLY 38 YEARS OLD. SHE WAS THE DYNAMIC YOUNG LADY. SHE WAS A CO-FOUNDER OF "CHILDREN TODAY," WHICH IS A LONG BEACH NONPROFIT THAT HELPED HOMELESS CHILDREN. UNDER HER LEADERSHIP, THE CHILDREN TODAY FLOURISHED FROM A VERY SMALL ORGANIZATION TO INCLUDE A VERY HUGE BASE OF VOLUNTEERS. FROM '97, WHEN THEY FIRST RAISED ABOUT $10,000 TO GET STARTED LAST YEAR, THEY RAISED ABOUT $400,000. THE GROUP'S CHILD CARE CENTER, THE PLAYHOUSE, RECENTLY EXPANDED ITS FACILITY TO CARE FOR MORE CHILDREN. SHE HAD A TRUE ADVENTUROUS SPIRIT AND INDOMITABLE WILL AND A VERY INFECTIOUS LAUGH. SHE LED FROM HER HEART AND WAS VERY PASSIONATE ABOUT THE CHILDREN IN THE COMMUNITY. SHE IS SURVIVED BY HER HUSBAND, BRIAN, HER CHILDREN, KATY AND JACKSON, HER MOTHER AND THREE SISTERS AND SHE WILL BE SORELY MISSED BY ALL. ALSO THAT WE ADJOURN IN MEMORY OF SARA GARO, WHO PASSED AWAY ON MARCH 2ND. SHE WAS BORN IN ENSENADA BUT LIVED MOST OF HER LIVE IN DOWNEY. SHE SPENT MANY, MANY HOURS VOLUNTEERING AND HOSTING FUNDRAISERS IN HER HOME FOR THE DOWNEY MUSEUM OF ART. SHE WAS ALSO A BOARD MEMBER FOR THE MUSEUM THAT HELPED THE ARMENIAN ARTS COUNCIL. SHE'S REMEMBERED AS HAVING GREAT ENERGY AND A SPARK THAT MADE OTHERS WANT TO WORK WITH HER AND TO BE AROUND HERE. SHE'S GOING TO BE SORELY MISSED. SHE'S SURVIVED BY HER DAUGHTERS, ELISHA, ELIZABETH, BROTHERS, JOHN, ART AND RAY, AND SISTER, SADIE, AND THREE GRANDCHILDREN. ALSO THAT WE ADJOURN IN MEMORY OF REVEREND JOHN OLDENBURGER, A LONG-TIME RESIDENT OF BELLFLOWER. HE'S SURVIVED BY HIS WIFE, SANDRA, CHILDREN, CAROL, JOHN, AND DONNA, BETH, 11 GRANDCHILDREN AND 11 GREAT- GRANDCHILDREN. FINALLY, THAT WE ADJOURN IN MEMORY OF DR. FELIX STARR, A 60-YEAR RESIDENT AND GENERAL PRACTITIONER IN THE CITY OF MANHATTAN BEACH. HE AND HIS WIFE RAN A SMALL MEDICAL OFFICE ON HIGHLAND AVENUE THAT WAS HOME TO SEVERAL CHILDREN GROWING UP IN MANHATTAN BEACH. DR. STARR WAS WELL KNOWN FOR BEING ONE OF THE FEW DOCTORS WHO STILL MADE HOUSE CALLS TO HIS PATIENTS AND THOSE ARE MY ADJOURNMENTS. 

SUP. MOLINA, CHAIR: THANK YOU. SO ORDERED ON THOSE ADJOURNMENTS. 

SUP. KNABE: AND I THINK THE ONLY ITEM THAT I HELD WAS ITEM 2, SO THAT-- WE TOOK CARE OF THAT. 

SUP. MOLINA, CHAIR: SO YOU HAVE NO OTHER ITEMS. ALL RIGHT. SUPERVISOR ANTONOVICH? 

SUP. ANTONOVICH: I'D LIKE TO MOVE WE ADJOURN IN MEMORY OF MAX FISHER. HE WAS AN OILMAN AND GREAT PHILANTHROPIST WHO PASSED AWAY AT THE AGE OF 96. HE HEADED THE UNITED JEWISH APPEAL, WAS A MAJOR BENEFACTOR OF THE DETROIT SYMPHONY. HE WAS ALSO A CONFIDANTE OF ALL THE REPUBLICAN PRESIDENTS, STARTING BACK WITH PRESIDENT EISENHOWER, WHO SOUGHT HIM OUT FOR ADVICE ON MIDDLE EASTERN ISSUES. HE FOUNDED THE NATIONAL JEWISH COALITION, AN ORGANIZATION OF JEWISH REPUBLICANS, AND WAS QUITE INVOLVED WITH GOVERNOR JEB BUSH'S CAMPAIGNS. ERNEST PADILLA, A WORLD WAR II VETERAN, FORMER POLICE OFFICER, AND BUSINESSMAN FOR 45 YEARS, A FORMER APPOINTEE OF GOVERNOR GEORGE DEUKMEJIAN. HIS COMPANY, HE IS PRESIDENT AND OWNER OF U.S. GUARDS COMPANY. GAINED NOTORIETY BY PROVIDING THE SECURITY FOR THE BEATLES AND THE ROLLING STONES, AMONG OTHERS. HE WAS AN ACTIVE MEMBER IN THE REPUBLICAN PARTY. HE WAS ACTIVE WITH THE SALESIAN AND SALVATION ARMY BOYS AND GIRLS CLUB OF LOS ANGELES AND THE LITTLE FLOWER MISSIONARY HOUSE PRESCHOOL RUN BY THE CARMELITE NUNS, OF WHICH HIS SISTER WAS A SISTER. 

SUP. KNABE: I'D LIKE TO BE ON THAT AS WELL. 

SUP. ANTONOVICH: RICHARD HARLAN MUMFORD. HE PASSES AWAY FROM ALZHEIMER'S DISEASE. HE WAS A RETIRED CHEMIST TEACHER AND SOCIAL WORKER FOR THE COUNTY OF LOS ANGELES FOR 23 YEARS. IRMA PAULA FRIEDMAN, WIFE OF DALE AND MOTHER OF CONNIE, PASSED AWAY AT THE AGE OF 84. SHE WAS QUITE ACTIVE IN THE ATWATER JOB'S DAUGHTERS, WHICH HER DAUGHTER WAS A PAST HONOR QUEEN AND ACTIVE IN THE COMMUNITY IN THE LOS FELIZ AREA. GEORGE WALSH, A RETIRED INSPECTOR FOR THE LOS ANGELES COUNTY SHERIFF'S DEPARTMENT. HE JOINED THE DEPARTMENT BACK IN 1948 AND HE PASSED AWAY ON FEBRUARY 27TH. AND WAYNE PULLEY, AGE OF 79, PASSED AWAY, RESIDENT OF PASADENA. HE DEVOTED 50 YEARS OF SERVICE TO THE LITTLE LEAGUE IN VARIOUS CAPACITIES SERVING IN LEADERSHIP AND HE IS SURVIVED BY LANELLE AND HIS 11 CHILDREN. AND THEN, FOR NEXT WEEK, I WOULD LIKE TO MOVE THAT THE C.A.O. REPORT TO THE BOARD OF SUPERVISORS ON MAKING THE OFFICE OF PUBLIC SAFETY INTO A SEPARATE DEPARTMENT WITH A REPORT BACK IN, LET'S SAY, 30 DAYS, DAVID? SHALL WE PUT THAT ON FOR NEXT WEEK OR JUST... 

C.A.O. JANSSEN: I THINK WE CAN JUST REPORT BACK, SUPERVISOR, IN 30 DAYS. 

SUP. ANTONOVICH: THANK YOU. THAT'S ALL I HAVE. 

SUP. MOLINA, CHAIR: ALL RIGHT. SO ORDERED ON MR. ANTONOVICH'S ADJOURNMENTS. I DON'T HAVE ANY ADJOURNMENTS THIS MORNING BUT I'D LIKE TO CALL UP ITEM NUMBER 23. IT'S BEEN HELD FOR A MEMBER OF THE PUBLIC. MR. ROBINSON, RICHARD ROBINSON. 

RICHARD ROBINSON: MADAM CHAIRWOMAN, MEMBERS, RICHARD ROBINSON. THE NECESSITY OF PRIVATIZING SOME OF THE COUNTY'S POLICE SERVICES INCLUDES PRUDENTIAL SECURITY SERVICES. MA'AM, THE AD HOC NATURE OF THIS ITEM INDICATES THE SCHIZOPHRENIC-LIKE NATURE OF COUNTY GOVERNANCE, THE SCHISMS AFFECTING COUNTY GOVERNMENT ARE GROWING. PUBLIC SAFETY, BEYOND COMMUNITY SAFETY WEEK, NEEDS BETTER PLANNING. I SUPPORT THIS HUMAN RESOURCE'S DEPARTMENT RECOMMENDATION FOR APPROVAL BUT CAUTION ALL OF YOU TO REMEMBER THAT THE NEED FOR PRIVATIZING MORE AND MORE COUNTY SERVICES ON A MONTH-TO-MONTH BASIS, AS NEEDED, PLAYS INTO THE HANDS OF THOSE WHO WILL TAKE AN ADVANTAGE OF YOUR GROWING LACK OF PLANNING FOR FUTURE SAFETY NEEDS. IT'S NOT ONLY THE COUNTY'S SEAL, WHICH IS AFFECTING THIS COUNTY'S-- THE LACK OF BIPARTISAN, INTELLIGENT DECISION- MAKING ALSO INDICATES THIS RIFT. THANK YOU. 

SUP. MOLINA, CHAIR: ALL RIGHT. THANK YOU SO MUCH. ON THAT ITEM, MOVED BY SUPERVISOR KNABE, SECONDED BY SUPERVISOR ANTONOVICH. IF THERE'S NO OBJECTION, SO ORDERED. ITEM NUMBER 4-- I MEAN ITEM NUMBER 27. I APOLOGIZE. MR. BAXTER? 

PETER BAXTER: MADAM CHAIR, MEMBERS OF YOUR HONORABLE BOARD, MR. JANSSEN, LADIES AND GENTLEMEN, MY NAME IS PETER BAXTER AND I LIVE IN LOS ANGELES. IT IS RESPECTFULLY SUBMITTED THAT THIS AGENDA ITEM IS SUBMITTED BY THE ACTING DIRECTOR OF PUBLIC WORKS FOR THE COUNTY OF LOS ANGELES. THE DEPARTMENT OF PUBLIC WORKS IS DESCRIBED IN THE OFFICIAL INFORMATION PROVIDED FOR THE PUBLIC AS FOLLOWS: DESIGNS-- I'M QUOTING: "DESIGNS, CONSTRUCTS, INSTALLS, OPERATES, MAINTAINS AND/OR REPAIRS ROADS, HIGHWAYS, BRIDGES, AIRPORTS, FLOOD CONTROL AND WATER CONSERVATION FACILITIES" AND A NUMBER OF OTHER ITEMS. THAT'S THE END OF THE QUOTATION. THE ABOVE STATEMENT DESCRIBED THE COMPREHENSIVE NATURE OF THE RESPONSIBILITIES OF THE DEPARTMENT OF PUBLIC WORKS AND SO IT WOULD APPEAR TO BE REASONABLE AND RESPONSIBLE TO SUBMIT BEFORE THE PROFESSIONAL ENGINEERS WHO STAFF THE DEPARTMENT OF PUBLIC WORKS THE FOLLOWING TWO QUESTIONS THUS: NUMBER ONE, DO THE PROPERTIES OF THE GAS STEAM HAVE THE EFFECT OF SUPPRESSING HOSTILE FIRE? THAT IS, SMOTHERING HOSTILE FIRE BY DENYING THAT FIRE THE GAS, OXYGEN, SO THAT FIRE, HOSTILE FIRE, IS UNABLE TO MEET THE PHYSICAL AND CHEMICAL ELEMENTS OF COMBUSTION SO THAT THE FIRE GOES OUT; AND (2) WOULD IT BE PHYSICALLY POSSIBLE TO PRESENT A HELICOPTER ON WHICH A STEAM-GENERATING MACHINE IS MOUNTED AT A FIRE SIMILAR TO THE TWIN TOWERS FIRES OF 9/11 IN MANHATTAN IN ORDER TO INTRODUCE STEAM UNDER PRESSURE TO PUSH OUT ALL THE OXYGEN- BEARING FRESH AIR UNTIL THE FIRE IS OUT. I ESPECIALLY MENTION THIS BECAUSE CHIEF FREEMAN, IN HIS LETTER OF JANUARY 18, USED THE WORD "IMPOSSIBLE". HE SAID IT WOULD BE IMPOSSIBLE TO DELIVER STEAM TO THE TOWERS-- TWIN TOWERS OF 9/11. THE WORD "IMPOSSIBLE" IS AN ABSOLUTE TERM. IT ALLOWS FOR NO QUALIFICATION AND I WOULD LIKE TO ASK THAT THE DIRECTOR OF PUBLIC WORKS WOULD KINDLY CONSIDER WHETHER OR NOT IT IS AS IMPOSSIBLE AS CHIEF FREEMAN SEEMS TO THINK IT IS. I SAY "SEEMS TO" BECAUSE, WHEN HE SPOKE TO ME, HE TOTALLY DISREGARDED HIS LETTER. BUT THE LETTER IS THE ONLY ITEM THAT I HAVE AVAILABLE TO ME AS FAR AS THE PUBLIC RECORDS IS CONCERNED, ALL OF WHICH IS RESPECTFULLY SUBMITTED AND I THANK YOU, MADAM CHAIR. 

SUP. MOLINA, CHAIR: THANK YOU, MR. BAXTER. ALL RIGHT. ON THAT ITEM, MOVED BY SUPERVISOR ANTONOVICH, SECONDED BY SUPERVISOR BURKE. IF THERE'S NO OBJECTION, SO ORDERED ON ITEM NUMBER 27. ALL RIGHT. THE NAVIGANT PEOPLE ARE STILL NOT HERE FOR THE 11:30 SET ITEM, SO I'M GOING TO MOVE FORWARD WITH PUBLIC COMMENT. WE HAVE SIGNED UP DOLORES RAMOS, IF SHE WOULD JOIN US. SECOND, GARY BARNETT, IF THEY'D JOIN US AND MR. ROBINSON. PLEASE PROCEED, MISS RAMOS. 

DELORES RAMOS: ALL GOOD MORNING, BOARD. I MEAN, MADAM CHAIR AND BOARD MEMBERS. I HAVE A COUPLE CHIEF COMPLAINTS. MY FIRST ONE IS MY FIRST GRADER, SHE'S DENIED ACCESS TO SCHOOL. I WORK FOR LABOR READY, MICHAEL BLEVIS AND WILLIE ALERCON. THEY GAVE PREVAILING WAGE JOBS TO MEN ONLY, THESE SAME MEN REPEATEDLY, BECAUSE THEY PAID THE MANAGERS $50 EACH AND EVERY DAY THEY WERE ON THOSE GOVERNMENT CONTRACT JOBS. NUMBER TWO, U.S.C. MEDICAL PSYCH WARD. ON FEBRUARY OF THIS YEAR, I WAS VICIOUSLY ATTACKED BY 68 BLACK STAFFERS, FACE COVERED WITH A SHEET WITH PRESSURE, ARMS AND LEGS BOUND IN EXCRUCIATING PAIN. REASON: I WAS TAKING HIGH BLOOD PRESSURE MEDICINE AND I SIMPLY, WOULD I HAVE A REACTION TO THE MEDICINE THEY WERE PLANNING ON GIVING ME? ONE OF THE BLACK STAFFERS, WHO LOOKED LIKE SHE WEIGHED A TON, SHE SAID, "GIRL, I SEE WE GOING TO HAVE PROBLEM. SHE AIN'T GOING TO TAKE HER MEDICINE," AND, WITH THAT, THEY ALL JUMPED ON ME, INCLUDING A DEPUTY SHERIFF. NO STAFF BEYOND THAT. I TRIED TO TELL THEM. THEY DID NOT CARE. L.A. HOSPITAL POLICE APPO DACCA, HE SAID I HAD NO RIGHTS. I RECEIVED A LETTER FROM A GEORGE ENGLISH, WHO IS SUPPOSED TO BE THE BUILDING MANAGER. HE SAID, "APPO DACCA SAID YOU ADMITTED TO SPITTING AND BITING THE STAFF," AND WHAT A BOLD-FACED LIE THAT IS. TO ACCOMPLISH THAT, I WOULD HAVE HAD TO HAVE BEEN HOUDINI. BUT I GUESS, YOU KNOW, IF YOU CARRIED AND A BADGE, THAT'S THE WAY HE WOULD LIE. DR. RODRIGUEZ CALLED ME AN A-HOLE FOR CONTEMPLATING SUICIDE AND THIS IS SUPPOSED TO BE A PSYCH DOCTOR. "I CAN LOCK YOU UP. THERE'S NOTHING YOU CAN DO ABOUT IT." THAT'S HOW PEOPLE ARE TREATED OVER THERE AND, BELIEVE ME, THREE MINUTES WOULDN'T DO WHAT I WITNESSED OVER THERE. VOLUNTEERS OF AMERICA, HOW IS 160 HOMELESS PEOPLE IN A CONDEMNED BUILDING OR SHOULD BE CONDEMNED? THERE IS NO HEAT, LITTLE TO NO PLUMBING. LAST INSPECTED DECEMBER 4TH, 2002. APPROVED FOR USE AS A CLINIC, NOT SLEEPING OR DINING. I CONTRACTED SCABIES, PEOPLE SLEPT ON BROKEN COTS, YET THESE COLD WEATHER SHELTERS RECEIVED UP TO $110,000 FROM DECEMBER TO MARCH. CURSED AT BY THE STAFF. THE STAFF ATE BEFORE THE HOMELESS. THEY LOST EVERYTHING. I HAD A MEDICAL EMERGENCY AND WENT TO THE HOSPITAL. VOLUNTEERS OF AMERICA OFFERED ME $40 FOR EVERYTHING, WHICH I FLATLY REFUSED. CALTRANS. I WORKED AT TEMPORARY AGENCY AT THE D.G.S. DEPARTMENT. I NEVER SEEN SUCH LAZY JANITORS. THEY USE STATE EMPLOYEE'S PHONES, THEY STOLE THEIR TREATS, THEY SLEPT. I REPORTED IT. AS A TEMP, I WAS LET GO. ALTHOUGH I WORKED LIKE TWO HEBREW SLAVES, THE SUPERVISOR GREW ANGRY AT ME BECAUSE I WOULDN'T LET HIM GIVE ME 30 MINUTES FOR BEING LATE. I TOLD HIM I WORKED THROUGH MY LUNCH, WHICH IS WHAT I DID. I REPORTED THE NEXT DAY. I WAS TOLD, "YOU DON'T WORK HERE NO MORE." THERE'S EMPLOYEE NAMED RUDOLPHO, HE SAID HIS UNCLE NEEDED A JOB. SAM, THE BUILDING MANAGER, CALLED HIM AND SAID, "WE NEED 19 JANITORS. SORRY, DOLORES, WE DON'T HAVE NOTHING FOR YOU." TWO BIGWIGS CAME DOWN FROM SACRAMENTO CAME DOWN AND THEY WERE IMPRESSED WITH MY WORK BUT, YOU KNOW, I REALLY CAN'T ANSWER THAT BEYOND THAT. ANOTHER THING IS I'M TIRED OF BEING DISCRIMINATED ON THESE JOBS BY HISPANICS WHO FEEL THEY CAN CALL YOU MINETAS AND _______________, THE EQUIVALENT OF STREET WALKERS AND THE "N" WORD. YOU REPORT IT AND NOTHING'S EVER DONE ABOUT IT AND I'M TALKING YEARS AND THERE WAS AN INCIDENT AT LABOR READY WHERE ROBERT CALDERON, HE TOLD HIS STAFF AT TIE SAFE CONSTRUCTION THAT I PROPOSITIONED HIM AND THAT, IF HE LIKED IT-- IF HE ENJOYED IT, THAT I WOULD CHARGE HIM. I REPORT THIS TO MICHAEL BLEVENS, THE MANAGER. HE SAID, "WELL, HE SAYS HE DIDN'T SAY THAT." WELL, DO YOU EXPECT HIM TO TELL THE TRUTH? BUT I MEAN, I ENJOYED DOING... 

SUP. MOLINA, CHAIR: DO YOU WANT TO SUMMARIZE YOUR COMMENTS, MISS RAMOS? 

DELORES RAMOS: OKAY. I WILL. EXCUSE ME? 

SUP. MOLINA, CHAIR: NO, I JUST WANTED YOU TO SUMMARIZE. AGAIN, I DON'T KNOW IF YOU HAVE COMPLAINTS THAT YOU CAN FILE AGAINST THE COUNTY. THERE'S A MECHANISM BY WHICH YOU COULD DO IT. WE CAN'T ADDRESS ANY OF THE ISSUES WITH CALTRANS OR ANY OF THAT. THERE IS SOMEONE OUT HERE THAT WILL HELP YOU IF YOU'RE INTERESTED IN DOING THAT. 

DELORES RAMOS: I DOUBT THAT SERIOUSLY. I HAVE NEVER GOTTEN HELP WITH ANYBODY. ALL I GET IS REFERRED TO THIS NUMBER, THAT NUMBER AND NOTHING. 

SUP. MOLINA, CHAIR: ALL RIGHT. THANK YOU, MISS RAMOS. 

DELORES RAMOS: THANK YOU. 

SUP. MOLINA, CHAIR: MR. BARNETT. 

GARY BARNETT: GOOD AFTERNOON, GLORIA MOLINA. I DID GET A LETTER FROM YOU. I WANT TO THANK YOU FOR YOUR SUPPORT ON IT. ALSO, I WANT TO KNOW IF THERE'S A POSSIBLE WAY THAT THE BOARD OF SUPERVISORS CAN MAKE A RECOMMENDATION TO GET A TASK FORCE FOR LOS ANGELES. I DO WORK AS A VOLUNTEER FOR ANTELOPE VALLEY. WE NEED TO GET ONE FOR L.A., IF IT'S POSSIBLE, BY THE BOARD OF SUPERVISORS, IF WE GET ONE FOR L.A., LOS ANGELES. 

SUP. MOLINA, CHAIR: PLEASE PROCEED, SIR. 

GARY BARNETT: HUH? I JUST WANT TO KNOW IF YOU CAN MAKE A RECOMMENDATION TO GET ONE FOR LOS ANGELES TASK FORCE BY THE BOARD OF SUPERVISORS? WE GOT ONE FOR ANTELOPE VALLEY, AND I TEND TO THAT EVERY MONTH. THAT'S FOR THE BOARDING CARE HOMES. 

SUP. ANTONOVICH: WHO FORMED THE TASK FORCE? 

GARY BARNETT: RICHARD COSLOWSKI. I GO WITH HIM ONCE A MONTH. HE'S FROM PATIENT RIGHT OFFICE. 

SUP. MOLINA, CHAIR: MR. BARNETT, AGAIN, FROM OUR OFFICE, WE'LL GET SOMEONE TO HELP YOU. WE HAVE PROVIDED ASSISTANCE IN THE PAST. THANK YOU, SIR. MR. ROBINSON. 

SUP. ANTONOVICH: IF IT'S A HEALTH DEPARTMENT, WE'LL HAVE-- RUSTY HERE WILL TAKE SOME INFORMATION. 

RICHARD ROBINSON: MADAM CHAIRWOMAN, MEMBERS, RICHARD ROBINSON. PRESIDENT BUSH'S OWNERSHIP SOCIETY INCLUDES REFORMING SOCIAL SECURITY. MA'AM? BECAUSE CERTAIN THINGS CANNOT BE EXPECTED, FOR EXAMPLE, IN THIS COUNTY, THE CITY IS NOT EXPECTED TO INTERFERE WITH COUNTY BUSINESS. THE MAYOR CANNOT TELL THE SCHOOL BOARD WHAT TO DO. CERTAIN THINGS LIKE SOCIAL SECURITY REFORM ARE THE RESPONSIBILITY OF THE FEDERAL GOVERNMENT. THE NEGATIVE TALK ATTACKING PRESIDENT BUSH, CAUSING HIM TO BE UNABLE TO EMPOWER SOCIAL SECURITY CONTRIBUTED. THOSE YET UNBORN. AS ELECTED OFFICIALS, YOU'RE NOT EXPECTED TO OBSTRUCT THE COMMON GOOD. THE STATUS QUO PRESENTLY IS IN FAVOR OF THE PRESIDENT'S REFORM OF SOCIAL SECURITY. YOU ARE EXPECTED TO ENGAGE IN THAT BIPARTISANSHIP AND I SAY THIS WITH THE EMOTION, WHICH FORMER MAYOR BRADLEY AND FORMER SUPERVISOR HAHN BROUGHT TO BOTH COUNTY AND CITY. FEDERAL RESERVE CHAIRMAN GREENSPAN, TREASURY SECRETARY SNOW, AND FORMER TREASURY SECRETARY O'NEAL INDICATE THAT THE REFORM NEEDED WILL PAY FOR ITSELF AS THE EFFECT OF PERSONAL RETIREMENT ACCOUNTS INCREASE COMPOUNDED RATES OF RETURN FOR INDIVIDUAL CONTRIBUTORS AGAIN YET UNBORN. A FOOLISH CONSISTENCY IS THE HOBGOBLIN OF LITTLE MINDS. RALPH WALDO EMERSON. REMEMBER, THOSE WHO FAIL TO PLAN, PLAN TO FAIL. DON'T FORGET TO VOTE. THANK YOU. 

SUP. MOLINA, CHAIR: THANK YOU, MR. ROBINSON. THAT CONCLUDES PUBLIC COMMENT. OUR LAST ITEM IS A SET ITEM, WHICH IS S-2 AND THAT IS THE REPORT FROM NAVIGANT. SO IF I COULD ASK THEM TO JOIN US, PLEASE. 

KAE ROBERTSON: GOOD MORNING. 

SUP. MOLINA, CHAIR: GOOD MORNING. PLEASE PROCEED. I'M SORRY. 

KAE ROBERTSON: THAT'S OKAY. WE'RE HERE THIS MORNING TO TALK ABOUT THE NOMINEES FOR THE HOSPITAL ADVISORY BOARD. AS YOU RECALL, IN OUR FEBRUARY REPORT, WE DELINEATED THE NEED FOR A HOSPITAL ADVISORY BOARD. THE CRITERIA FOR THE ADVISORY BOARD MEMBERSHIP WAS DELINEATED IN THAT REPORT AND IT'S BEEN AVAILABLE TO THE PUBLIC FOR ABOUT A MONTH AND IT'S ALSO ONLINE AT THE D.H.S. WEBSITE. JUST TO REFRESH EVERYBODY'S MEMORY, THE CRITERIA, AS WRITTEN IN THE REPORT, ARE MEMBERS WHO HAVE DEMONSTRATED EXPERTISE AND EXPERIENCE IN FINANCE, BUSINESS, HOSPITAL OR CLINIC MANAGEMENT, HEALTH PLAN ADMINISTRATION AND/OR HEALTH AND PUBLIC POLICY. THE MEMBERS SO APPOINTED SHOULD HAVE A CLEAR COMMITMENT TO THE PROVISION OF HIGH QUALITY HEALTHCARE TO UNDERSERVED POPULATIONS. TODAY, WE ARE PRESENTING FOR APPROVAL TO THE BOARD OF SUPERVISORS A LIST OF 10 NOMINEES FOR THE HOSPITAL ADVISORY BOARD, THE ADDITIONAL THREE NOMINEES WILL BE PRESENTED FOR APPROVAL AT A FUTURE BOARD OF SUPERVISORS MEETING. THE EX-OFFICIO VOTING MEMBERS, DIRECTOR OF HEALTH SERVICES, THOMAS GARTHWAITE, M.D., THE P.S.A. PRESIDENT ROBSON SCOTT, M.D., THE DREW UNIVERSITY BOARD CHAIR, BART HARPER WILLIAMS. FILLING OUT OTHER CRITERIA WITH EXPERIENCE IN ACADEMIC MEDICINE, MICHAEL V. DRAKE, M.D. HE WAS ALSO PREVIOUSLY A MEMBER OF THE PRIOR ADVISORY BOARD. JOSEPH VANDERMULEN, M.D., ALSO PREVIOUSLY A MEMBER OF THE ADVISORY BOARD; EXPERIENCE IN HOSPITAL NURSING MANAGEMENT, LINDA BURNS- BOLTON. EXPERIENCE IN COMMUNITY MEDICINE, HECTOR FLORES, M.D. EXPERIENCE IN PUBLIC HEALTH MANAGEMENT, KENNETH W. KAISER, M.D. EXPERIENCE IN HEALTHCARE AND/OR BUSINESS ADMINISTRATION, JAMES LOTT, WHO WAS ALSO FROM THE PREVIOUS ADVISORY BOARD. WOODROW A. MEYERS, M.D. AND THE SLOTS STILL TO BE FILLED ARE HOSPITAL ADMINISTRATOR, TO BE DETERMINED, SOMEONE WITH EXPERIENCE IN EITHER HOSPITAL OR-- HOSPITAL FINANCIAL MANAGEMENT OR FINANCIAL MANAGEMENT IN HOSPITAL, NURSING OR BUSINESS ADMINISTRATOR, STILL TO BE DETERMINED, SO THOSE ARE THE THREE SLOTS LEFT. WE CONTINUE TO BELIEVE IT'S VERY IMPORTANT TO WORK WITH LOCAL S.E.I.U. AND I BELIEVE A LABOR MANAGEMENT COMMITTEE INVOLVING THE STAFF WILL BE VERY IMPORTANT TO THE SUCCESS OF THE CLINICAL TURNAROUND. WE'RE CERTAINLY APPRECIATIVE OF THE WORK THAT WE'VE DONE TOGETHER CONTRIBUTING TO THE REMOVAL OF THE C.M.S. IMMEDIATE JEOPARDY AND ARE HOPEFUL TO HAVE A MEETING IN THE NEAR FUTURE WITH THEM REGARDING OUR OVERALL REPORT. 

SUP. MOLINA, CHAIR: ALL RIGHT. SO THIS IS THE PROPOSED SLATE. DOES THIS COMPLETE THE SLATE, AS YOU SEE IT? 

KAE ROBERTSON: NO. THE SLATE HAS THREE SLOTS STILL AVAILABLE. THE SLOTS AVAILABLE ARE FOR A HOSPITAL ADMINISTRATOR, HOSPITAL NURSING OR BUSINESS ADMINISTRATOR AND A HOSPITAL C.F.O. 

SUP. MOLINA, CHAIR: ALL RIGHT. MR. JANSSEN? 

C.A.O. JANSSEN: MADAM CHAIR, THANK YOU. I KNOW THAT WE'VE ALL HAD COMMUNICATIONS FROM LOCAL 660 WHO REPRESENTS, I BELIEVE, A HUNDRED PERCENT OF THE EMPLOYEES IN THE HEALTH DEPARTMENT REQUESTING A STRONGER ROLE IN THE ADVISORY BOARD. AND I'M GOING TO RECOMMEND THAT WE ADD TO THE SLATE PROPOSED BY NAVIGANT THAT KATHY OCHOA, REPRESENTING 660, BE ADDED AS ONE OF THE ADDITIONAL MEMBERS FOR YOUR CONSIDERATION. 

SUP. MOLINA, CHAIR: ALL RIGHT. THAT IS THE SLATE THAT IS BEFORE US. ANY QUESTION OR COMMENT? 

SUP. YAROSLAVSKY: I'D MOVE THAT AS AN AMENDMENT. 

SUP. KNABE: SECOND. 

SUP. MOLINA, CHAIR: IT'S BEEN MOVED AND SECONDED AS AN AMENDMENT TO THE SLATE. ANY QUESTION OR COMMENT? IF NOT... 

SUP. ANTONOVICH: JUST ON THAT ISSUE, WE'RE GOING TO HAVE OTHER QUESTIONS TO BE RAISED. 

SUP. MOLINA, CHAIR: OH, YOU KNOW, WE DO HAVE PUBLIC COMMENT, WE HAVE PEOPLE THAT WANT TO COMMENT ON THIS ITEM, BUT GO AHEAD. 

SUP. ANTONOVICH: THE QUESTIONS, YOU KNOW, GO BACK, REALLY, TO THE ISSUE OF THE COMMISSION. DR. GARTHWAITE AND WE'VE HAD EXTENSIVE DISCUSSIONS WITH THIS BUT TO DAVID JANSSEN, WHY IS THE C.A.O. PROPOSING THAT THE BUDGET FOR TRAVEL COSTS AND RELATED EXPENSE FOR THE KING DREW ADVISORY BOARD WHEN THIS IS SUPPOSED TO BE A VOLUNTEER BODY THAT WOULD NOT TAKE-- COST ANY ADDITIONAL FUNDS? MR. JANSSEN? 

C.A.O. JANSSEN: I CAN'T ANSWER THAT, SUPERVISOR. 

SUP. ANTONOVICH: OKAY. 

C.A.O. JANSSEN: KAE? TOM? 

KAE ROBERTSON: I'LL ANSWER IT. IT IS THE VOLUNTARY BOARD BUT PEOPLE ARE BEING REIMBURSED FOR THEIR TRAVEL. SOME ARE IN SAN FRANCISCO AND SOME WILL HAVE SOME OTHER COMMUTES THAT IT WOULD BE REASONABLE AND CUSTOMARY TO REIMBURSE TRAVEL. IT DOESN'T APPEAR TO BE A LARGE EXPENSE. 

SUP. ANTONOVICH: WHAT IS THE BUDGET GOING TO BE? 

KAE ROBERTSON: WE HAVEN'T FINALIZED ALL THE MEMBERS, SO IT'S NOT POSSIBLE TO GIVE YOU THAT BUDGET YET. 

SUP. ANTONOVICH: HOW CAN WE VOTE ON IT IF WE DON'T HAVE THE COSTS? 

KAE ROBERTSON: AT THE MOMENT, THERE ARE TWO MEMBERS WHO HAVE A LONGER COMMUTE. 

SUP. ANTONOVICH: I KNOW BUT WE HAD A DOCTOR THAT PERFORMED THREE SURGERIES A YEAR THAT WAS GETTING $500,000 OR SO, YOU KNOW, I MEAN... 

DR. THOMAS GARTHWAITE: WELL, THESE ARE-- THIS ONLY CONTEMPLATES THE TRAVEL EXPENSES AND IF THE MEETINGS START OUT EVERY MONTH BUT THAT THEN ARE EVEN MORE-- LONGER SPACING AND IF-- OFTEN IT'S IMPOSSIBLE TO GET EVERY MEMBER TO EVERY MEETING. IT SEEMS TO ME THAT YOU'RE LOOKING AT A MAXIMUM OF PROBABLY SIX TO EIGHT TRAVELS PER YEAR FOR TWO MEMBERS, SO YOU'RE PROBABLY TALKING IN THE RANGE OF 10 TO 12,000 MAXIMUM. FOR, REALLY, VOLUNTEER TIME FROM-- THERE WAS SOME-- WE WERE, I THINK, LUCKY TO HAVE, FOR INSTANCE, DR. KAISER VOLUNTEER. HE WAS THE FORMER DIRECTOR OF THE STATE HEALTH DEPARTMENT AND HEADS THE NATIONAL QUALITY FORUM, HAS ALSO BEEN INVOLVED IN A LOT OF OTHER HEALTHCARE ACTIVITIES, HAS A NATIONAL REPUTATION AND WILLING TO PROVIDE HIS TIME FREE OF CHARGE. 

SUP. ANTONOVICH: DR. GARTHWAITE, SINCE THE ADVISORY BOARD HAS NO AUTHORITY OVER THE BUDGET AND KING DREW PERSONNEL AND ALL RESPONSIBILITIES AND ACCOUNTABILITY RESTS WITH THE BOARD OF SUPERVISORS, WHO WILL BE PROVIDING CLARIFICATION AS TO HOW THIS ADVISORY BOARD WILL BE HELD ACCOUNTABLE AND WHO WILL HAVE OVERSEE THEIR WORK? 

DR. THOMAS GARTHWAITE: WELL, AS I HAVE UNDERSTOOD THIS, THE ADVISORY BOARD WOULD OBVIOUSLY PUT FORWARD RECOMMENDATIONS TO THE BOARD THAT-- AND THE DEPARTMENT WILL COMMENT IN TWO WAYS: ONE, WE'LL CERTAINLY COMMENT, BECAUSE I'LL BE ON THE BOARD AND REPRESENTATIVE IN THE DIALOGUE AND DISCUSSION. IF THE DEPARTMENT HAS A CONTRARY VIEW, I WOULD EXPECT THAT THIS BOARD WILL WANT TO HEAR THAT AND, YOU KNOW, ON THOSE RARE OCCASIONS WHERE THERE IS DIVERGENCE OF A VIEW, WE WOULD PROVIDE THOSE SEPARATELY. 

SUP. ANTONOVICH: HOW IS-- DOES A QUORUM HAVE TO EXIST PRIOR TO ANY DISCUSSION BY THE ADVISORY BOARD? 

KAE ROBERTSON: THE BYLAWS ARE STILL BEING PREPARED. 

SUP. ANTONOVICH: SO YOU HAVE TO HAVE A QUORUM FOR THE ADVISORY BOARD TO MEET? 

KAE ROBERTSON: THE BYLAWS ARE NOT COMPLETE YET. I'M SURE THAT THE BYLAWS WILL STATE YOU NEED A QUORUM BUT THEY AREN'T COMPLETED YET. AS WE SAID, WE WOULD BE BRINGING THE BYLAWS TO A FUTURE MEETING FOR APPROVAL. 

SUP. ANTONOVICH: DO YOU ENVISION THE ADVISORY BOARD MEETING WITHOUT A QUORUM? 

KAE ROBERTSON: NO, I DON'T ENVISION THAT. 

SUP. ANTONOVICH: SO, IF YOU DON'T HAVE A QUORUM, THERE WILL BE NO MEETING? 

KAE ROBERTSON: RIGHT. 

SUP. ANTONOVICH: WILL THE KING DREW ADVISORY BOARD OVERRIDE ANY RECOMMENDATIONS MADE BY THE EXISTING COUNTY'S HOSPITALS AND HEALTH DELIVERY COMMISSION? 

KAE ROBERTSON: I'M NOT SURE I UNDERSTAND THE QUESTION. IF YOU COULD RESTATE IT FOR ME? 

SUP. ANTONOVICH: WELL, ARE YOU GOING TO BE ABLE TO-- YOU HAVE A COUNTY'S HOSPITAL AND HEALTH DELIVERY COMMISSION RIGHT NOW? 

KAE ROBERTSON: YEAH. 

SUP. ANTONOVICH: WILL THESE ADVISORY BOARD BE ABLE TO OVERRIDE ANY OF THEIR RECOMMENDATIONS? 

KAE ROBERTSON: THE ADVISORY BOARD WILL BE FOCUSED ON THE WORK OF KING DREW MEDICAL CENTER AND WILL NOT BE FOCUSED ON COUNTYWIDE ISSUES. 

SUP. ANTONOVICH: IN THE FEBRUARY 22ND MEETING THAT WE HAD, YOU HAD MENTIONED THAT THE ADVISORY BOARD WOULD PROVIDE THE BOARD WITH SUMMARIES ON SPECIFIC RECOMMENDATIONS ON ISSUES THAT THEY HAD NOTICED-- YOU HAD NOTICED AT KING DREW AND THE STATUS AS TO WHETHER THESE RECOMMENDATIONS ARE BEING IMPLEMENTED. WHY CAN'T THIS BE DONE BY A NEW POSITION THAT THE BOARD APPROVE THE CHIEF HEALTHCARE NETWORK OFFICER, THE PERMANENT KING DREW C.E.O. AND THE CHIEF NURSING OFFICER WHO NEEDS TO BE HIRED? 

DR. THOMAS GARTHWAITE: WELL, I THINK LARGELY THE DAY-BY-DAY ADMINISTRATION OF AND CORRECTION OF VARIOUS DEFICIENCIES WILL BE MONITORED AND VARIOUS ISSUES THAT WILL ARISE AS WE TRY TO FIX THINGS BOTH AT KING DREW AND THROUGHOUT THIS SYSTEM WILL BE MONITORED BY SOME OF THOSE INDIVIDUALS. I THINK WHAT THE HEALTH ADVISORY BOARD ADDS, IN MY VIEW, IS A SEPARATE SET OF HEALTH EXPERTISE THAT WILL ASK WHETHER OR NOT THAT'S BEING DONE QUICKLY ENOUGH, WHETHER ALL THE THINGS THAT NEED TO BE DONE ARE BEING DONE. IT'S RELATIVELY EASY, ONCE YOU IDENTIFY SOMETHING, TO GO AHEAD AND MOVE TO FIX THAT AND IT'S EASY TO SEE THE THINGS THAT ARE BROKEN. THE HARDEST THING IS TO SEE THE THINGS THAT ARE MISSING AND THAT'S TRUE PER ANY VENTURE, CERTAINLY TRUE IN HEALTHCARE AND MANAGEMENT. AND ADDITIONAL EXPERTS IN HEALTHCARE, I THINK, ADD THAT PARTICULAR PIECE AND ADD THOSE QUESTIONS TO THE DIALOGUE. 

SUP. ANTONOVICH: IT'S MY UNDERSTANDING THAT NAVIGANT IS NOW GOING TO BE REQUESTING A MULTI-MILLION-DOLLAR INCREASE IN THEIR CONTRACT. WHAT'S THE STATUS OF THAT REQUEST? 

DR. THOMAS GARTHWAITE: WE'VE BEEN ENGAGED IN DIALOGUE. WE SPENT THE BETTER PART OF YESTERDAY AND HAD PREVIOUS MEETINGS TRYING TO UNDERSTAND THE DETAIL OF THAT. WE WOULD EXPECT TO HAVE THAT MAYBE FINISHED UP THOUGH LATER THIS WEEK. SO IT'S IN PROGRESS. 

SUP. ANTONOVICH: THE REASON OF A CONCERN IS THAT ONE OF THE COMPETING CONSULTING COMPANIES INDICATED THAT NAVIGANT'S BID WAS TOO LOW TO BE RELEVANT AND IT WAS UNREALISTIC AND THAT WE WOULD BE NICKLED AND DIMED AFTER THE CONTRACT WAS AWARDED ON THAT BASIS SO I WOULD LIKE TO BE APPRISED OF THAT. 

DR. THOMAS GARTHWAITE: OUR DIALOGUE IS AROUND TRYING TO-- IF WE COME FORWARD WITH CHANGES, THAT THIS WOULD BE ONE-TIME CHANGE FOR THE REST OF THE CONTRACT PORTION AND THAT IT WOULD BE-- IT WOULD TAKE INTO ACCOUNT EVERYTHING WE CAN FORESEE AT THIS TIME AND WE WOULD NOT BE BACK TO THE BOARD NICKEL AND DIMING, IF YOU WILL, WE'D MAKE ONE ADJUSTMENT BASED ON IDENTIFIED NEED, WHICH WAS ANTICIPATED IN THE ORIGINAL CONTRACT. 

SUP. ANTONOVICH: BUT THE COMPETING VENDORS WERE INDICATING THAT THEIR PRICE DID NOT INCLUDE ADDITIONAL COMPENSATION ONCE THE CONTRACT WAS AWARDED. IN FACT, ONE WAS GOING TO GIVE BACK FUNDS IF THEY WEREN'T ABLE TO COMPLETE THEIR JOB IN A SHORTER TIME FRAME. 

DR. THOMAS GARTHWAITE: I THINK THAT THE CURRENT NUMBERS THAT WE ARE TALKING ABOUT, THAT THERE'S STILL A SIGNIFICANT GAP BETWEEN THE TWO DIFFERENT-- THE TWO BIDS. 

SUP. ANTONOVICH: THE C.A.O. HAS STATED THAT THE BARD HARPER WILLIAMS, WHO IS THE CHAIR OF THE BOARD OF THE TRUSTEES AT DREW UNIVERSITY, WILL BE AN EX-OFFICIO VOTING MEMBER OF THE HOSPITAL BOARD. COUNTY COUNSEL HAS NOT ADDRESSED HOW CONFLICTS OF INTEREST WILL BE ADDRESSED SINCE MR. WILLIAMS IS PART OF THE MEDICAL AFFILIATION CONTRACT WITH THE DREW UNIVERSITY. WHEN DO-- FROM THE COUNTY COUNSEL WILL WE RECEIVE THAT OPINION? 

KAE ROBERTSON: SUPERVISOR ANTONOVICH, I BELIEVE WE HAVE SENT A MEMO TO YOUR BOARD REGARDING THE CONFLICT OF INTEREST ISSUES. WHAT WE STATED WAS THAT THE BYLAWS WILL CLEARLY DELINEATE THAT THE MEMBERS WILL BE FOLLOWING THE STATE CONFLICT LAWS AS REQUIRED SPECIFICALLY RELATING TO DISQUALIFICATION. SO FOR THE EXAMPLE THAT YOU'VE CITED, THAT INDIVIDUAL WILL BE REQUIRED TO ABSTAIN FROM ANY DISCUSSIONS REGARDING THE AFFILIATION AGREEMENTS. 

SUP. ANTONOVICH: THERE WAS AN AUDIT IN 2002, THE DEPARTMENT OF HEALTH SERVICES INSPECTION, THE PHARMACY AT KING DREW REGARDING ALLEGED INCOMPETENCIES. DID THE DEPARTMENT IMPLEMENT THOSE RECOMMENDATIONS MADE BY THE INSPECTION AND AUDIT COMMITTEE? THOSE ALLEGATIONS WERE UNABLE TO LOCATE PHARMACY STAFF DURING WORKING HOURS, INEXPERIENCED COUNTY EMPLOYEES APPOINTED TO PHARMACY-RELATED POSITIONS AND PRESCRIPTION DRUGS SOLD BY PHARMACY STAFF INAPPROPRIATELY IN DRUG STOCKROOM. THAT WAS YOUR REPORT THAT YOU HAD DONE. 

DR. THOMAS GARTHWAITE: RIGHT. I BELIEVE THAT MOST OF THEM BEEN IMPLEMENTED BUT NOT ALL AND WE'RE WORKING ON THE OTHERS. 

SUP. ANTONOVICH: SEE, MY CONCERN IS THAT THAT WAS DONE IN 2002, WE THOUGHT NAVIGANT WAS GOING TO COME IN AND ENSURE THAT ALL OF THE AUDITS WERE BEING COMPLIED WITH, ALL OTHER SUGGESTIONS WOULD BE IMPLEMENTED AND THE FIRST THING WE REALLY GET, THE BIG ENCHILADA, IS FORMING ANOTHER COMMITTEE AND IT SEEMED LIKE EDUCATIONAL ENVIRONMENT WHERE ALL THEY DO IS FORM COMMITTEES INSTEAD OF ATTACKING THE PROBLEMS. AND THAT WAS A CONCERN BUT MR. LEAF SAID SOMETHING... 

DR. THOMAS GARTHWAITE: YEAH. FRED SAID THAT HE BELIEVES THAT FOR THAT PARTICULAR REPORT, ALL OF THEM HAVE BEEN IMPLEMENTED AND WE WILL PROVIDE YOU A COPY OF THE AUDIT TRAIL AND THE FOLLOW-UP. 

SUP. ANTONOVICH: CAN THE-- THANK YOU. WE'LL GET A REPORT, THEN, ON THAT. THANK YOU. COULD THE COUNTY COUNSEL PROVIDE INFORMATION ON WHAT BYLAWS SHOULD SAY REGARDING CONFLICTS SO THAT THE BOARD KNOWS HOW CONFLICTS NEED TO BE HANDLED? 

KAE ROBERTSON: SUPERVISOR, WE CAN DO THAT FOR YOU, YES. 

SUP. ANTONOVICH: YOU KNOW, GOING BACK TO THE-- FORMING THIS COMMITTEE, I'VE STATED BEFORE, I'LL STATE AGAIN THAT THE REASONS I DON'T SUPPORT THE ADVISORY BOARD OR BUDGETING FOR TRAVELING AND OTHER EXPENSES TO A BOARD THAT IS SUPPOSEDLY A VOLUNTEER BOARD. THE FACT THAT DR. GARTHWAITE ALREADY HAS THE AUTHORITY AND FULL SUPPORT OF THE BOARD TO MAKE THOSE DECISIONS OF WHAT NEED TO BE DONE TO IMPROVE CLINICAL CARE AND QUALITY ASSURANCE, A KING DREW ADVISORY BOARD CANNOT BE EFFECTIVE WITH NO AUTHORITY WHEN THEY MEET ON A MONTHLY BASIS AND REPORT TO OUR BOARD QUARTERLY. THIS SEEMS VERY FAR REMOVED. NAVIGANT IS ALREADY BEING PAID OVER $13.2 MILLION TO DO A JOB AND THERE WAS A REQUEST FOR A FEW MORE MILLION DOLLARS. THE DEPARTMENT OF HEALTH SERVICES, IT'S ABOUT $232 MILLION THAT WE PAY EACH YEAR FOR ADMINISTRATION TO OVERSEE THE HOSPITALS AND OTHER HEALTH DEPARTMENT PROGRAMS. AND FORMING A HOSPITAL ADVISORY BOARD FOR KING DREW AND THEN TO HAVE DR. GARTHWAITE SIT ON THE HEALTH ADVISORY BOARD AS AN EX-OFFICIO TO MAKE RECOMMENDATION TO HIMSELF AND WHAT POLICIES HE NEEDS TO FOLLOW WHEN HE ALREADY HAS THE ABILITY TO MAKE THOSE DECISIONS AND TO IMPLEMENT THOSE AUDITS THAT HAVE BEEN FORTHCOMING TO THE BOARD. MOREOVER, NAVIGANT AND THE DEPARTMENT HAS NOT STARTED RECRUITMENT FOR A PERMANENT CHIEF EXECUTIVE OFFICER AND A CHIEF NURSING OFFICER FOR KING DREW AS OF TODAY. KING DREW DOES NEED A PERMANENT C.E.O. AND A PERMANENT CHIEF NURSING OFFICER TO OVERSEE THE VARIOUS PROGRAMS THERE WHILE WE WORK ON IMPROVING... 

KAE ROBERTSON: WE DO AGREE WITH THAT AND I THINK THERE'S A SALARY SURVEY BEING CONDUCTED FOR THE C.E.O. AND THE EXPECTATION IS TO BEGIN RECRUITMENT IN THE MONTH OF MARCH AS PER THE CONTRACT. 

SUP. ANTONOVICH: I KNOW BUT HOW MANY TWEAKS HAVE YOU BEEN ON THE CONTRACT? 

KAE ROBERTSON: WE'RE FOLLOWING THE CONTRACT, WHICH IS WE'RE WAITING FOR THE SALARY SURVEY TO BE COMPLETED, IT IS COMPLETED, I THINK IT WILL BE COMING TO THIS BOARD AND WE'LL BEGIN OUR RECRUITMENT FOR THOSE POSITIONS. 

SUP. ANTONOVICH: WHEN DID YOU FIRST GET THE CONTRACT TO DO THE OVERSIGHT OF KING DREW? 

KAE ROBERTSON: WE BEGAN AT KING DREW IN NOVEMBER AND THE CONTRACT STATED WE WOULD BEGIN RECRUITMENT FOR OUR REPLACEMENTS IN MARCH. 

SUP. ANTONOVICH: OKAY. SO THERE WAS NOVEMBER, DECEMBER, JANUARY, AND NOW WE'RE STILL TRYING TO FIGURE OUT A PAY SCALE. THAT SEEMS A LITTLE ELEMENTARY WHEN YOU HAVE ALREADY FIVE OR SIX HOSPITALS, PRIVATE-- PUBLIC HOSPITALS PLUS A NUMBER OF PRIVATE HOSPITALS IN THIS AREA TO GET THAT INFORMATION FOR SALARIES, SHOULD NOT TAKE THAT MANY MONTHS. WE WERE TOLD RECRUITMENT WOULD BE DONE IN MARCH. THE SURVEY SHOULD HAVE BEEN ALREADY DONE BECAUSE WE'RE NOW ENTERING THE SECOND WEEK OF MARCH. 

KAE ROBERTSON: I BELIEVE THE COUNTY'S HAD SOME DIFFICULTY GETTING RESPONSES TO THE SURVEY BUT I CAN'T SPEAK FOR THEM. 

SUP. ANTONOVICH: THAT'S JUST-- THANK YOU. 

SUP. MOLINA, CHAIR: ALL RIGHT. YOU WANT TO SUMMARIZE, MR. ANTONOVICH? OKAY. WE HAVE SOME PEOPLE THAT WISH TO ADDRESS THIS ITEM: DR. GENEVIEVE CLAVREUL, KATHY OCHOA AND JILL FURILLO. IF YOU'LL JOIN US, PLEASE. PLEASE PROCEED. 

DR. GENEVIEVE CLAVREUL: GOOD AFTERNOON, BOARD OF SUPERVISORS. NO, ACTUALLY, IT'S STILL GOOD MORNING. DR. GENEVIEVE CLAVREUL. YOU KNOW, WE ARE BACK AT THE SAME ISSUE ALL THE TIME, YOU KNOW. WE HAD A COMPANY AT THE TUNE OF $13.2 MILLION. IT WAS ANOTHER COMPANY COMPETING FOR THE SAME R.F.P., AND I DON'T KNOW HOW MANY PEOPLE OF THIS BOARD ACTUALLY READ THE LETTERS ANN CAMBIO SENT AFTER THEY WERE REFUSED THE R.F.P. THAT LETTER WAS EXTREMELY PRECISE, CLEARLY OUTLINING WHY THE JOB COULD NOT BE DONE FOR THE $13.2 MILLION AND, OF COURSE, WE'RE GETTING A PIECE OF THE TASTE RIGHT NOW, WHEN NAVIGANT HAS BEEN ON THE JOB SINCE NOVEMBER 1ST. AS WE LOOK AT THE EVENTS GOING ON AT KING DREW, WE KNOW THINGS ARE FAR FROM BEING SOLVED AND THEY'RE ASKING FOR MORE MONEY. YOU KNOW, WHEN I SEE THE ANSWER FROM MR. FRED LEAF TO THE CAMDEN COMPANY, IS A NON-RESPONSE AND I THINK THAT'S WHAT'S AT THE ROOT OF THE PROBLEM, R.F.P.S. THE WAY THIS BOARD REVIEWS R.F.P., I MEAN, SOME OF YOU REVIEW THEM WELL BUT I'M TALKING THE BROAD "YOU." THE SAME, YOU KNOW, TOMORROW, AT THE HEAD DEPUTY MEETING, WE ARE HAVING AN ITEM FOR THE LIMBAUGH ASSOCIATE TO GET A SOLE VENDOR CONTRACT ON AN R.F.P. FOR JOINT ACCREDITATION SURVEY OF YOUR HOSPITAL. LIMBAUGH, A COMPANY WHO MAKE YOU LOSE YOUR ACCREDITATION AT KING DREW. THERE'S SOMETHING WRONG WITH THAT PICTURE. I MEAN, NAVIGANT HAS BEEN HERE FOR A FEW MONTHS ALREADY. WE ARE GETTING, WELL, IT'S IN PROCESS, IT WILL BE DONE IN TWO WEEKS AND SO ON. I GOT PHONE CALL LAST NIGHT FROM KING DREW NOTIFYING ME THAT A LOT OF DOCUMENTS ARE BEING SHREDDED BY NAVIGANT. I WOULD LIKE PEOPLE TO LOOK INTO THAT, BECAUSE MEDICAL RECORDS CANNOT BE SHREDDED. SO I WILL HOPE THAT, WHEN YOUR TEAM WILL PAY ATTENTION TO WHAT'S GOING ON AT KING DREW. ALSO, THAT ADVISORY BOARD WE ARE BEING PUSHED DOWN OUR THROATS, HOW ARE THOSE PEOPLE-- HOW COME THEY COME TO THE BOARD WITH ONLY ONE SLATE OF PEOPLE? IT SHOULD HAVE BEEN A CHOICE BETWEEN TWO AND THREE PEOPLE FOR EACH POSITION, IF TRULY THEY HAD DONE THEIR JOB. I THINK YOU ARE TOTALLY BEING SNOWED IN AGAIN. AND, AS SUPERVISOR ANTONOVICH SAID, YOU KNOW, WHY SHOULD YOU BE ADVISED-- GETTING ADVICE WHERE YOU ALREADY HAVE THE POWERS? I THINK IT IS ANOTHER LAYER AND I THINK WE SHOULD HAVE A CHOICE-- YOU SHOULD HAVE HAD A CHOICE OF MORE THAN ONE PEOPLE FOR EACH POSITION. SO I HOPE YOU ARE NOT GOING TO VOTE ON THAT BLANKET REPRESENTATION. AND, AGAIN, THE REPRESENTATION FOR NURSING IS NOT THERE AND THAT'S ONE OF YOUR KEY ISSUES AT KING DREW MEDICAL CENTER. 

SUP. MOLINA, CHAIR: THANK YOU, DR. CLAVREUL. KATHY? 

KATHY OCHOA: GOOD MORNING, SUPERVISORS. KATHY OCHOA, S.E.I.U. LOCAL 660. I'D LIKE TO THANK THE BOARD OF SUPERVISORS FOR YOUR RESPONSIVENESS TO OUR CONCERNS. S.E.I.U. LOCAL 660 WILL CONTINUE OUR WORK TO FULFILL THIS BOARD'S GOALS, THEY ARE COMPATIBLE WITH OURS. NAMELY, ONE, TO PRESERVE AND RESTORE APPROPRIATE ACCREDITATION AT KING DREW MEDICAL CENTER WITH ADHERENCE TO HIGH STANDARDS OF CARE FOR PATIENTS AND, TWO, IN DOING SO, TO SPECIFICALLY WORK TO CREATE CONDITIONS FOR THE FULL RESTORATION OF SERVICES, INCLUDING TRAUMA, AT KING DREW MEDICAL CENTER. SUPERVISORS, WE HAVE CONDUCTED OUR OWN DUE DILIGENCE WITH RESPECT TO THE NOMINEES AND HAVE FOUND THEM TO BE ALMOST OVERWHELMINGLY PERSONS OF THE HIGHEST INTEGRITY. WE WOULD LIKE TO EXPRESS OUR DISSATISFACTION AND CONCERN, HOWEVER, WITH A NOMINEE WHO-- LINDA BURNS BOLTEN, WHO HAS A DEMONSTRATE RECORD OF ANTI-LABOR PRACTICES THAT MY COLLEAGUE, JILL FURILLO, WILL EXPLAIN MORE IN DETAIL TO YOU. THANK YOU. 

SUP. MOLINA, CHAIR: THANK YOU. MISS FURILLO? 

JILL FURILLO: YES. GOOD MORNING. MY NAME IS JILL FURILLO. I AM... 

SUP. MOLINA, CHAIR: SPEAK A LITTLE LOUDER. 

JILL FURILLO: OH, I'M SORRY. OKAY. I'M JILL FURILLO AND I AM A REGISTERED NURSE AND I AM THE SOUTHERN CALIFORNIA DIRECTOR FOR THE CALIFORNIA NURSES ASSOCIATION. WE REPRESENT THOUSANDS OF NURSES HERE IN THE L.A. COUNTY AND VARIOUS HOSPITALS, MOSTLY IN THE PRIVATE SECTOR, ALTHOUGH WE DO REPRESENT THEM IN THE ANTELOPE VALLEY, WHICH IS A DISTRICT HOSPITAL AS WELL. 

SUP. YAROSLAVSKY: YOU KNOW, IT'S VERY HARD TO HEAR YOU, SO IF YOU CAN RAISE YOUR VOICE A LITTLE LOUDER. 

JILL FURILLO: ALL RIGHT. I CAN BE LOUD, IF YOU WANT ME TOO. OKAY. I'M JILL FURILLO. I'M FROM THE CALIFORNIA NURSES ASSOCIATION, WE REPRESENT THOUSANDS OF NURSES IN L.A. COUNTY, MOSTLY IN PRIVATE HOSPITALS, WITH THE EXCEPTION OF ANTELOPE VALLEY, WHICH IS A DISTRICT HOSPITAL. I'M HERE AT THE REQUEST OF KATHY OCHOA, LOCAL 660, TO TELL YOU ABOUT OUR EXPERIENCES WITH LINDA BURNS-BOLTON, WHO IS THE CHIEF NURSING OFFICER AT CEDARS-SINAI MEDICAL CENTER. OUR EXPERIENCE, WE REPRESENT HUNDREDS OF NURSES AT CEDARS-SINAI. WE HAD AN ELECTION THERE ABOUT TWO YEARS AGO AND DR. BURNS BOLTON WAS FRONT AND CENTER INVOLVED IN MANY, MANY UNFAIR LABOR PRACTICE CHARGES THAT WERE SUBSTANTIATED BY THE NATIONAL LABOR RELATIONS BOARD IN THAT CAMPAIGN. BESIDES HER ACTIVITY WITH RESPECT TO ANTI-UNION ACTIVITY, SHE ALSO OVERSAW ONE OF THE WORST CASES OF TIMECARD FRAUD AT CEDARS-SINAI THAT WE KNOW ANYWHERE IN ANY HOSPITAL IN L.A. COUNTY OR ANY OTHER HOSPITAL IN CALIFORNIA. SPECIFICALLY, THE LABOR COMMISSIONER'S OFFICE DID A TWO-YEAR ONGOING INVESTIGATION AT CEDARS AND THEY FOUND THAT MANAGERS WERE UNDER THE TUTELAGE OF DR. LINDA BURNS BOLTON WERE TELLING NURSES AND OTHER DIRECT PATIENT CARE EMPLOYEES TO PUT THEIR TIMECARD, TO CLOCK IN THEIR TIMECARD TO CLOCK OUT AND THEN TO COME BACK TO WORK AND SO THIS WENT ON FOR A PERIOD OF ABOUT TWO YEARS AND THE LABOR DEPARTMENT'S INVESTIGATION SHOWED THAT THERE WERE MANY, MANY PEOPLE WHO WERE IMPROPERLY PAID WITH RESPECT TO OVERTIME AND IT WAS A MASSIVE OVERTIME FRAUD CASE. AS A RESULT, CEDARS HAD TO PAY OVER $1.3 MILLION BACK TO NURSES AND OTHER WORKERS THERE IN THAT FACILITY. JUST A WEEK AGO, THE DEPARTMENT-- THE LABOR COMMISSIONERS' OFFICE ORDERED CEDARS ANOTHER RE-AUDIT BECAUSE THEY FOUND THAT THEY DID NOT COME FORTH WITH RESPECT TO THE AUDIT IN PUTTING FORTH ALL THE INFORMATION. AND SO IT LOOKS LIKE THERE'S GOING TO BE ANOTHER FEW MILLION DOLLARS THAT ARE GOING TO HAVE TO BE PAID OUT THERE. THIS IS ALL UNDER THE TUTELAGE OF LINDA BURNS-BOLTON, SO THIS IS OF CONCERN, I THINK IT SHOULD BE OF CONCERN TO THE BOARD, IN LOOKING FOR A PERSON TO FIT THE CRITERIA THAT WAS ESTABLISHED, I BELIEVE-- THAT WAS SPOKEN TO BY NAVIGANT CONSULTING WITH RESPECT TO EXPERTISE IN MANAGEMENT. WE ARE LOOKING FOR GOOD MANAGEMENT PRACTICES. THERE ARE OTHER ISSUES AT CEDARS I DON'T WANT TO GO INTO EXTENSIVELY BECAUSE I HAVE 30 SECONDS BUT JUST TO SAY THERE ARE SEVERAL PATIENT CARE ISSUES IN THAT FACILITY. WE DO HAVE A DOCUMENT THAT WE CAN GIVE YOU AND WE WILL DISTRIBUTE TO YOU WITH RESPECT TO THAT, THAT, AGAIN, WITH DR. LINDA BURNS-BOLTON BEING IN CHARGE OF THAT FACILITY, WE WOULD HAVE MAJOR CONCERNS ABOUT THAT. THANK YOU. 

SUP. MOLINA, CHAIR: THANK YOU, MISS FURILLO. ALL RIGHT. THAT CONCLUDES PUBLIC COMMENT. THE ITEM IS BEFORE US AS AMENDED. DO WE NEED TO CALL THE ROLL? CALL THE ROLL. 

SUP. ANTONOVICH: ONE MOMENT. CAN WE DIVIDE THE QUESTION ON THE AMENDMENT? I'LL VOTE ON THE AMENDMENT, BUT I'M GOING TO INCLUDE THEM BY POSING THE... 

SUP. YAROSLAVSKY: MADAM CHAIR, I HAVE NO PROBLEM WITH THAT. IF I CAN JUST ALSO RAISE, CAN WE ASK KAY TO COME BACK AND JUST ADDRESS THAT BRIEFLY? 

SUP. MOLINA, CHAIR: MS. ROBERTSON, IF YOU'D JOIN US AGAIN, PLEASE? 

SUP. YAROSLAVSKY: I JUST DON'T WANT TO LEAVE THESE STATEMENTS HANGING AND I KNOW THAT THERE HAS BEEN A WAR GOING ON, I'VE FOLLOWED IT QUITE CLOSELY BETWEEN CEDARS MANAGEMENT AND LABOR AND IT'S UNFORTUNATE AND IT'S ONGOING AND THERE ARE-- SOME OF THE STATEMENTS THAT HAVE BEEN MADE, I THINK, ARE WORTH NOTING BUT THEY AREN'T NECESSARILY-- WE HAVEN'T HEARD THE OTHER SIDE. AND I'M NOT SURE THAT ANY OF THAT, IN TERMS OF THE LABOR PIECE OF IT, IS RELEVANT TO THE FUNCTION THAT THIS INDIVIDUAL IS BEING ASKED TO PERFORM ON THIS ADVISORY COMMITTEE. AND THAT'S WHAT I WOULD LIKE TO ADDRESS-- YOU TO ADDRESS, "A" AND, "B," I'D LIKE YOU TO ADDRESS, TO THE EXTENT YOU CAN, ANY OF THE STATEMENTS THAT WERE JUST MADE BY THE REPRESENTATIVE OF THE NURSES ASSOCIATION. 

KAE ROBERTSON: IN TERMS OF THE COMPETENCY THAT DR. BOLTON BRINGS, IT IS IN NURSING CARE. IT'S NOT IN UNION LABOR MANAGEMENT. OBVIOUSLY, I THINK YOU'VE ADDED SOMEBODY ELSE TO THE BOARD WHO HAS THAT COMPETENCY AND DR. BOLTON IS RESPECTED IN THE PROFESSION. THERE CAN BE INSTANCES WHERE THERE ARE LAPSES IN CLINICAL CARE AT EVERY HOSPITAL IN THE U.S. IT IS NOT THE CHIEF NURSING OFFICER WHO IS PROVIDING THE CARE AT THAT TIME. IT'S THEIR JOB TO SET UP THE BEST SYSTEMS AND CEDARS-SINAI HAS A NATIONAL REPUTATION FOR HIGH QUALITY NURSING CARE, WHICH IS WHY WE WOULD LIKE TO HAVE DR. BOLTON AS PART OF THE BOARD. 

SUP. MOLINA, CHAIR: ALL RIGHT. I JUST WOULD LIKE TO SAY THAT I HOPE THAT EVERYBODY RECOGNIZES AND UNDERSTANDS THAT THERE'S BEEN EXPERTISE THAT HAS BEEN BROUGHT TO THIS ADVISORY BOARD, AND WE DIDN'T ASK THEM TO BRING THEIR BIASES, WE ASKED THEM TO BRING THEIR EXPERTISE AND TO GET TOGETHER AND COLLECTIVELY SOLVE THE PROBLEM AT MARTIN LUTHER KING, WHICH IS TO SAVE THE HOSPITAL, BRING BACK TRAUMA ONLINE, BRING IT BACK TO THE LEVEL OF SERVICES THAT WE HAVE HIGH EXPECTATIONS FOR IN THE COMMUNITY. SO I HOPE EVERYBODY UNDERSTANDS THAT IT'S NOT A WINDOW DRESSING THAT WE'RE ASKING FOR HERE. THEY'RE GOING TO HAVE TO ROLL UP THEIR SLEEVES, WORK VERY HARD COLLECTIVELY TO MAKE SURE THAT WE CAN BRING BACK THAT HOSPITAL TO THE LEVEL OF COMPETENCY THAT WE WOULD LIKE TO SEE AND IT IS GOING TO BE A CHALLENGE. THEY ARE TO WORK, AS I UNDERSTAND AND, KAY, CORRECT ME IF I'M WRONG, ON THE AGENDA ITEMS THAT WERE ENUMERATED AS YOU SHARED WITH US OF THE EXPECTATIONS. I AM MONITORING THOSE EXPECTATIONS BECAUSE I WANT TO SEE THEM COMPLETED AND I AM GOING TO BE ASKING, FROM TIME TO TIME, MEMBERS OF THAT COMMITTEE AS TO HOW WE'RE DOING ON THAT. SO I HOPE IT ISN'T EVERYBODY COMING IN AND THINKING THAT THEY ARE TO PRESERVE OR PROTECT THEIR OWN SPECIAL INTERESTS THAT THEY THINK THEY MAY REPRESENT BUT IT IS THE COLLECTIVE INTERESTS OF TRYING TO REPRESENT HOW YOU'RE GOING TO ADVISE US, ADVISE THE DEPARTMENT AND ADVISE US TO HOW WE ARE GOING TO GET THIS HOSPITAL BACK IN SHAPE TO SERVE THE COMMUNITY THAT IT IS SERVING TODAY AND TO SERVE IT AT A LEVEL THAT IS COMPETENT AND ADEQUATE AND BRING BACK ALL THE ACCREDITATION THAT WE NEED SO IT CAN LINE UP WITH THE REST OF OUR HOSPITALS IN THE KIND OF STATURE THE REST OF OUR HOSPITALS HAVE. SO I HOPE THAT'S UNDERSTOOD. 

KAE ROBERTSON: THAT IS OUR UNDERSTANDING AND OUR HOPE AS WELL. WE EXPECT THE BOARD TO BE A TEAM, NOT TO REPRESENT ANY FACTIONS OR CONSTITUENCIES. I ACTUALLY PERSONALLY ENJOY WORKING WITH SEIU 660 AND KATHY OCHOA. I THINK SHE'LL BE A GOOD ADDITION TO THE BOARD, SO I THINK EVERYBODY WILL BE ABLE TO BRING THEIR REAL HOPES FOR RETURNING KING DREW TO THE STATUS IT WAS BEFORE TO THE TABLE AND WORK WELL AS A TEAM. I THINK IT WILL BE A GOOD EFFORT. 

SUP. MOLINA, CHAIR: GOOD. WE APPRECIATE THAT. 

SUP. BURKE: MADAM CHAIR, I THINK IT'S VERY IMPORTANT TO HAVE PEOPLE WHO HAVE RELATIONSHIPS WITH THE ACCREDITING BODIES AND WHO HAVE A GOOD RECORD OF BEING ABLE TO ACHIEVE ACCREDITATION IN THEIR INSTITUTION. THEY CAN BRING TO KING DREW THEIR KNOWLEDGE OF WHAT IT REALLY TAKES IN ORDER TO MEET THE EXPECTATIONS FOR ACCREDITATION AND SOMETIMES THAT'S BEEN LACKING AT KING DREW AND I DON'T KNOW WHAT THIS WOMAN'S-- REPRESENTATION-- WHAT THE REPRESENTATIONS AS FAR AS HER LABOR MANAGEMENT BUT IF SHE CAN JUST BRING KING DREW TO THE SAME LEVEL OF RESPECT AS CEDARS-SINAI, WE'LL BE VERY, VERY HAPPY. 

KAE ROBERTSON: ABSOLUTELY. ABSOLUTELY. 

SUP. MOLINA, CHAIR: VERY GOOD. ALL RIGHT. WE'RE GOING TO SPLIT THE ITEM. FIRST, ON THE AMENDMENT, WHICH IS TO ADD KATHY OCHOA TO THE SLATE OF NOMINEES FOR THE HEALTH ADVISORY BOARD AT KING DREW. 

CLERK VARONA-LUKENS: AND WHO MADE THAT MOTION? 

SUP. MOLINA, CHAIR: IT WAS MADE BY SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR BURKE. 

CLERK VARONA-LUKENS: SO ON THE AMENDMENT, SUPERVISOR BURKE? 

SUP. BURKE: AYE. 

CLERK VARONA-LUKENS: SUPERVISOR YAROSLAVSKY? 

SUP. YAROSLAVSKY: AYE. 

CLERK VARONA-LUKENS: SUPERVISOR KNABE? 

SUP. KNABE: AYE. 

CLERK VARONA-LUKENS: SUPERVISOR ANTONOVICH? 

SUP. ANTONOVICH: AYE. 

CLERK VARONA-LUKENS: AND SUPERVISOR MOLINA? 

SUP. MOLINA, CHAIR: AYE. THAT ITEM PASSES. OKAY. ON THE SLATE AS AMENDED. 

CLERK VARONA-LUKENS: SUPERVISOR BURKE? 

SUP. BURKE: AYE. 

CLERK VARONA-LUKENS: SUPERVISOR YAROSLAVSKY? 

SUP. YAROSLAVSKY: AYE. 

CLERK VARONA-LUKENS: SUPERVISOR KNABE? 

SUP. KNABE: AYE. 

CLERK VARONA-LUKENS: SUPERVISOR ANTONOVICH? 

SUP. ANTONOVICH: NO. 

CLERK VARONA-LUKENS: AND SUPERVISOR MOLINA? 

SUP. MOLINA, CHAIR: AYE. THAT ITEM PASSES. ALL RIGHT. WE HAVE AT LEAST THE INITIAL SLATE. GOOD LUCK. WE ALL LOOK FORWARD TO WORKING WITH EACH OF YOU TO HELP BRING BACK THE KIND OF LIFE THAT WE'D LIKE TO SEE AT MARTIN LUTHER KING. ALL RIGHT. THANK YOU. I THINK THAT CONCLUDES ALL OF THE ITEMS BEFORE OUR AGENDA, I WILL HAVE OUR EXECUTIVE OFFICER READ US INTO CLOSED SESSION. 

CLERK VARONA-LUKENS: IN ACCORDANCE WITH BROWN ACT REQUIREMENTS, NOTICE IS HEREBY GIVEN THAT THE BOARD OF SUPERVISORS WILL CONVENE IN CLOSED SESSION TO DISCUSS ITEM CS-1, CONFERENCE WITH LABOR NEGOTIATORS DAVID E. JANSSEN, AND DESIGNATED STAFF, AS INDICATED ON THE POSTED AGENDA. THANK YOU. 
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